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CHAPTER - 1 
 

SOFTWARE AND OPERATING SYSTEM CONCEPTS 

 

OBJECTIVES OF THIS LESSON 
 
This lesson is aimed to make you understand the basic concepts of software and operating systems. 
Readers will be able to understand the following: 

 Software and its different types such as programming software, system software, application 
software and other software types 

 Application software and its various types such as general-purpose application packages, 
application-specific packages and customised application packages 

 Operating system and its characteristics, desirable features of operating system 

 Classification of operating systems and their families 

 Functions of operating system, main functions, basic roles of operating system, OS as an 
extended machine and as a Resource Manager 

 
 
 

STRUCTURE OF THIS LESSON 

 
1.1 Introduction 
1.2 Software Types 

1.2.1 Programming Software 
1.2.2 System Software 
1.2.3 Application Software 
1.2.4 Other Software Types 

1.3 Application Software 
1.3.1 General-purpose Application Packages 
1.3.2 Application-specific Packages 
1.3.3 Customised Application Packages 

1.4 Operating System 
1.4.1 Control Programs 
1.4.2 Processing Programs 

1.5 Characteristics of Operating System 
1.6 Desirable Features of Operating System 
1.7 Booting (or Bootstrapping) 
1.8 Family of Operating Systems 
1.9 Functions of Operating System 

1.9.1 Main Functions 
1.9.2 Basic Roles of Operating System 
1.9.3 OS as an Extended Machine 
1.9.4 OS a Resource Manager 

1.10 Classification of Operating Systems 
 Summary of the Lesson 

Self Assessment Questions and Exercises 
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1.1 INTRODUCTION 

The hardware alone can’t perform any particular calculation, computation or manipulation without 
being instructed exactly what to do, when to do and how to do it. These instructions are very 
important and are called software. 
 
The software acts as an interface between the user and the computer or a software can be defined as a 
complete set of instructions written by the programmer which enables the computer to obtain the 
solution to a problem.  
 
Software may be viewed as a general term that is used to describe any single program or a group of 
programs.  
 
In its most general form, software is a term used in contrast to hardware to refer to all programs 
which can be used on a particular computer system i.e. the term software is used to describe program 
sets needed to operate an information processing system. 

1.2 SOFTWARE TYPES 

Software is the means by which computer systems speak with computer users. Software forms the 
heart of computer systems.  
 

 
 

Figure 1.1 
Software, by definition, is the collection of computer programs, procedures and documentation that 
performs different tasks on a computer system. The term 'software' was first used by John Tukey in 
1958. Briefly, computer software is the language in which a computer speaks. There are different 
types of computer software.  
 

1.2.1 Programming Software 
 
This is one of the most commonly known and popularly used forms of computer software. These 
software come in forms of tools that assist a programmer in writing computer programs. Computer 
programs are sets of logical instructions that make a computer system perform certain tasks. The tools 
that help the programmers in instructing a computer system include text editors, compilers and 
interpreters. 
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1.2.2 System Software 

 
It helps in running the computer hardware and the computer system. System software is a collection 
of system programs; device drivers, servers, windowing systems and utilities. System software helps 
an application programmer in abstracting away from hardware, memory and other internal 
complexities of a computer. 
 

1.2.3 Application Software 

 
It enables the end users to accomplish certain specific tasks. Business software, databases and 
educational software are some forms of application software. Different word processors, which are 
dedicated for specialized tasks to be performed by the user, are other examples of application 
software. 
 
1.2.4 Other Software Types 
 
Apart from these three basic types of software, there are some other well-known forms of computer 
software like inventory management software, ERP, utility software, accounting software and others.  

1.3 APPLICATION SOFTWARE 

An application package or application program is the software that has been written to process or 
perform specific job. The term application indicates that the software is applied to the  job  at hand. 
application packages are available for all types  of  tasks. These programs are called Application 
Packages because they accomplish the processing required for a particular application. They may be 
for business applications, engineering  designs,  home applications, teaching aids etc.  
An end-user wishing to use an application package has to define his own requirements by means of 
parameters, which are employed by the programs in the system to produce the specific results 
required. These are usually written in high-level languages. Of course, the application packages run 
under the control of the operating system.  

Application software is developed to aid in any task that benefits from computation. It is a broad 
category, and encompasses software of many kinds, including the internet browser being used to 
display this page. This category includes: 

 Business software 
 Computer-aided design 
 Databases 
 Decision making software 
 Educational software 
 Image editing 
 Industrial automation 
 Mathematical software 
 Medical software 
 Molecular modelling software 
 Quantum chemistry and solid state physics software 
 Simulation software 
 Spreadsheets 
 Telecommunications (i.e., the Internet and everything that flows on it)  
 Video editing software 
 Video games 
 Word processing 

and so on. 
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Application packages can be classified as: 

 General-purpose Application Packages 

 Application-specific Packages 

 Customised Application Packages 

1.3.1 General-purpose Application Packages 

It is that class of application packages that perform  quite commonly used day-to-day tasks and also 
increase the productivity very significantly and that’s why these are also known as productivity 
packages. 
Some important examples of this category include: 

 Word processing packages for processing and manipulating text 

 Spreadsheet packages for calculating finances and data analysis 

 CAD for designing or drafting 

 Database packages for management of files, database, storage and retrieval of information 

 Engineering design packages 

 Communication packages 
 Integrated packages, etc. 

 
Some integrated packages have been developed which combine  the functions of word processing, 
spreadsheets,  graphics,  database management and communication into a single software. MS-Office, 
Framework and Symphony are good examples of  Integrated Packages. 

1.3.2 Application-specific Packages 

It is the type of application packages specifically meant for accomplishing a uncommon application. 
Few important examples include : 

* General Application Packages 
* Payroll 
* Personnel Management 
* Attendance Management 
and so on. 

* Business Application Packages 
* Inventory Control 
* Finance and Accounting 
* Marketing Analysis 
* MRP (Material Requirements Planning) 
* Human-resource Management 
and so on 

* Scientific Application Packages 
* Computer-Aided Designing and Drafting (CADD) 
* SPSS (Statistical Package For Social Sciences)  
* Computer-Aided Manufacturing (CAM) 
* Statistical Analysis Software (SAS) 
and so on. 

* Miscellaneous Application Packages 
* Computer-Based Learning (CBL) 
* MIDI (Musical Instrument Digital Interface) Package 
* Computer-Based Training (CBT) 
and so on 
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1.3.3 Customised Application Packages 

It is a kind of application packages developed by the professional programmers. It has become the 
trend of the present day Software Industry to develop such kind of packages. Natural Language 
Processing (NLP) is getting world-wide attention because these are non-procedural and are more 
closer to human conversation. This is trend has been geared up probably due to the development of 
the non-procedural 4GLs (4

th
 Generation Languages). This trend will continue to grow as the 

development in multimedia, graphics, artificial intelligence, networking solutions enhance. 
 

1.4 OPERATING SYSTEM 
 
“Operating System (OS) is a collection of software written to provide the fundamental instructions 
that a computer needs to manage resources, such as memory, the file system, and processes”.  
 
In other words, OS is a master program that controls a computer's basic functions and allows other 
programs to access the computer's resources such as disk drive, printer, keyboard, and screen. 
 
There are several definitions of operating system. Few of these are: 
 
 “Operating system is a set of system programs which controls all the computer’s resources and 
provides the base upon which application programs can be written”. 
OR 
“An operating system may be viewed as an organised collection of software extensions of hardware, 
consisting of control routines for operating a computer and for providing an environment for 
execution of programs”. 
OR 
“An operating system is a set of procedures (manual and/or automatic) that enables people or group 
of people to share a computer installation efficiently”. 
OR 
―An operating system is a program that act as an intermediary between a user of a computer and the 
computer hardware. The primary goals of an operating system are: 

 To make the computer system convenient to use and 

 To use the computer hardware in an efficient manner” 
OR 
“An operating system is an integrated collection of subsystems and further each subsystem consists of 
programs that perform specific duties. Just as the processor is the nucleus of the computer system, the 
operating system is the nucleus of all types software activities”. 

Examples of operating systems: Linux, MS Windows 95, MS Windows NT, Windows XP, UNIX, 
DOS and OS/2. 

Remarks 



 
Fig. 1.2: Layers of Computer System 

     It co-ordinates all the hardware and software components of a computer 
                 

 

Fig. 1.3: OS as Co-ordinator 
 
The following two types of programs make up the operating system: 

i) Control programs and 
ii) Processing programs 
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1.4.1 Control Programs 
These programs oversee system operations and  performs  tasks such  as  input/output,  scheduling,  
handling   interrupts,   and communication with computer operator or  programmer.  The  control 
programs consist of the following : 

a) Supervisor Programs 
b) Job Control Programs 
c) Input/Output Management Program 

 

1.4.2 Processing Programs 
These are  executed  under  the  supervision  of control programs and  are  used  by  the  programmer  
to  simplify program operation for the computer system. They  include  language translator programs, 
link editors, library programs and a  set  of utility programs. These programs collectively automate 
the management of all  the computing resources available in a computer system including  CPU, all 
peripherals,  and  software.  This  integrated  collection  of programs provides  more  efficient  
computer  operation.  Improved operating convenience is another benefit of an operating system. 
Typically, operating systems (OSs) are  used  in  microcomputer systems. They require mass storage 
media such as magnetic tape  or floppy disk. most microcomputers  systems  use  operating  systems 
only with  floppy  disk  mass  storage. For this reason, these operating systems are referred to as disk 
operating systems (DOS).  The most commonly used operating systems on personal computers are 
MS-DOS and PC-DOS. 

1.5 CHARACTERISTICS OF OPERATING SYSTEM 

 Sharing 

 Concurrency 
 Long-term Storage 

 Non-determinacy 

1.6 DESIRABLE FEATURES OF OPERATING SYSTEM 

 Efficiency 

 Reliability 

 Small-Size 

 Maintainability 
Thus the operating system is responsible for directing a  given computer into a batch mono-
programming system,  a  multi-programmed system,  a  time-sharing  system  or  a  real-time  system.   
Many operating systems can handle both batch and real-time applications simultaneously.  

1.7 BOOTING (OR BOOTSTRAPPING) 

The process of loading the operating system into memory is known as booting. When a  computer  is  
turned  on  the  operating system must be brought  into  the  memory  of  computer  from  the hard-
disk storage. The process is  normally  started  by  a  small program called bootstrap loader. This 
program resides in a ROM  as a firmware. A  computer  is  designed  to  fetch  its  very  first 
instruction from the ROM  when  power  is  turned  on.  The  first instruction  is  bootstrap  loader.  It  
is  very  simple  program sufficient only to direct the CPU to look for specific file on the disk 
memory, and executes the instructions stored in the file. The file contains machine codes to direct the 
CPU to continue  loading the rest of  the  operating  system  into  the  memory.  When the operating 
system is fully loaded into the memory, the computer is ready to accept user’s commands.  

1.8 FAMILY OF OPERATING SYSTEMS 
The family of operating systems have evolved over the years: 

a) Windows family of OS:  
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Windows 1.0  
Windows 2.0  
Windows 3.0 (the first version to make substantial commercial impact)  
Windows 3.1x  
Windows 95 (aka Windows 4.0)  
Windows 98 (aka Windows 4.1)  
Windows Me (aka Windows 4.2)  
OS/2 (developed jointly with IBM)  

  

Windows NT  
Windows 2000 (aka Windows NT 5.0)  
Windows XP (aka Windows NT 5.1)  
Windows Server 2003 (aka Windows NT 5.2)  
Windows Vista (to be released August 2006)  
Windows Longhorn Server (to be released shortly after Windows Vista)  
Microsoft Codename Blackcomb (to follow Vista) 

   
b) Apple/Macintosh 

Apple DOS  
ProDOS  
GS/OS  
Lisa OS  
A/UX  
Mac OS  
System 6  
System 7 (code-named "Big Bang")  
Mac OS 8  
Mac OS 9  
Mac OS X  
Mac OS X v10.0 (aka Mac OS X 10.0 "Cheetah")  
Mac OS X v10.1 (aka Mac OS X 10.1 "Puma")  
Mac OS X v10.2 (aka Mac OS X 10.2 "Jaguar")  
Mac OS X v10.3 (aka Mac OS X 10.3 "Panther")  
Mac OS X v10.4 (aka Mac OS X 10.4 "Tiger")  
Mac OS X v10.5 (aka Mac OS X 10.5 "Leopard")  
Mac OS X Server  
Darwin 

c) Unix 
d) Linux 
e) Solaris. 

1.9 FUNCTIONS OF OPERATING SYSTEM 

The main functions of OS are:  
1. It manages the hardware and software resources of the system. In a desktop computer, these 

resources include such things as the processor, memory, disk, etc. 
2. It provides a stable, consistent way for applications to deal with the hardware without having 

to know all the details of the hardware. 
 

 

 

 

1.9.1 Main Functions 
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OS acts as an interface between hardware and users. It controls overall operations of computers. It is 
mainly used for job management, data management, virtual memory management, input/output 
management, process management, security etc. 
 

a) Job Management: OS manages the job waiting to be processed. It recognizes the jobs, 
identifies their priorities, allocates the memory for the job, schedules and finally runs each 
job at the appropriate moment.  

b) Data Management: Data management keeps track of the data on disk, tape and optical 
storage devices. The operating system's file system knows where that data are physically 
stored. 

c) Virtual Storage Management: OS is used for virtual memory management. OS makes 
possible to increase the capacity of main memory with out actually increasing its size. 

d) Input/output Management: OS manages the input and output operation of computer. This 
applies to the flow of data among the different devices of computer and application programs. 

e) Process Management: The main activities of process management are job queuing, job 
scheduling, keeping track of the status of each process etc. 

f) Protection and Security: OS job is to secure data inside the memory of computer. Operating 
systems provide password protection to keep unauthorized users out of the system. 

g) User Interface: OS acts as an interface between a user of a computer and the computer 
hardware. 

 
1.9.2 Basic Roles of Operating System 

 
a) Easy interaction between human and computer. 
b) Starting computer operation automatically.  
c) Loading and scheduling users’ programs/processes. 
d) Controlling I/O devices 
e) Managing various types of memories such as primary, secondary, cache etc. 
f) Providing security to users’ jobs and files. 
g) Accounting hardware resources and handling network communication.  
h) Allowing users to share data and software among themselves. 
i) Preventing the system from unauthorized user, programs etc. 

1.9.3 OS as an Extended Machine 

The OS effectively isolates the hardware  from  the  user.  The user communicates only with  the  OS  
and  it  links  the  various languages and the systems and applications programs available. The OS 
fields all requests for services  and  totally  eliminates  the need for the user to deal with the hardware 
or  related  problems.  Thus  the operating system allows the user to concentrate  on  his application 
and prevents him for having to spend  a  lot  of  time determining how things are  to  be  specifically  
accomplished  by the hardware. 
In this view, the function of an operating system is to prevent the user with the equivalent of an 
Extended Machine or Virtual Machine that is easier to program than the underlying hardware. 
 

1.9.4 OS a Resource Manager 

An operating system’s major function is to manage the resources of the computer system. It allocates 
the resources on the basis of the user need and system capability. The four major functions of an 
operating system are: 

i)  File and Software Management 
ii)  Input/Output and Peripheral Management 
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iii)  Memory Management 
iv)  Processor (or CPU) Management 

 
As a Resource Manager, the operating system must perform the following functions for each resource 
viz. processor, memory, I/O, files : 

a)  Keep track of status of each resource 
b)  Decide which job should get the resource and for how much time, according to some 

policy 
c)  Allocate the resource to the job decided 
d)  After the resource is used by the job for the allocated time, make the resource free 

1.10 CLASSIFICATION OF OPERATING SYSTEMS 

 
Within the broad family of operating systems, these may be categorized based on the types of 
computers they control and the sort of applications they support. These may be classified in the 
following categories: 

 Single-user, Single-task Operating System 

 Single-user, Multi-task Operating System 

 Multi-user (or time-sharing) Operating System 

 Multi-access Operating System 

 Multi-processing Operating System 

 Multi-tasking and Multi-threading Operating System 
 Real-time Operating System 

 Distributed Operating System 

 Embedded Operating System 
 

Single-user, single task Operating System 
 
As the name implies, this operating system is designed to manage the computer so that one user can 
effectively do one thing at a time. The Palm OS for Palm handheld computers is a good example of a 
modern single-user, single-task operating system. Other examples of such operating systems include 
MS-DOS, PC-DOS, etc. 

 

Single-user, multi tasking Operating System 
 
This operating system allows a computer to perform more than one task at a time. Microsoft's 
Windows and Apple's Mac OS (Leopard) platforms are both examples of operating systems that will 
let a single user have several programs in operation at the same time. 

Multi-user (or time-sharing) Operating System 

 
A multi-user operating system allows many different users to take advantage of the computer's 
resources simultaneously. UNIX, VMS and mainframe operating systems, such as MVS, are examples 
of multi-user operating systems.  
 
These operating systems allow two or more users to run their respective programs at the same time by 
making all these programs resident in the memory of computer. Such operating systems are normally 
made to work on minicomputers and mainframe computers. 
 
Examples : VMS (on DEC Mainframes), UNIX, XENIX, MVS, etc. 

Multi-access Operating System 
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In a multi-access operating system, a user may submit a job by typing on a terminal and may use the 
terminal to monitor and control the job as it runs. These operating systems allow simultaneous access 
of a single application onto a computer system through two or more terminals. 
 
The operating system shares the computing resources among the different jobs so that it appears to 
each user that he has entire machine to himself. 
 
An example is provided by some dedicated transaction-processing systems, such as Airline Ticket 
Reservation Systems, that supports hundreds of active terminals under control of a single program.  

Multiprocessing Operating System 

It is that class of operating systems that have the ability to support more than one process at the same 
time i.e. allowing more than one programs to run concurrently on the multiple CPUs in a single 
computer system. These operating systems differ from the time-sharing (or multi-user) operating 
systems in the manner that these refer to utilisation of multiple CPUs. 
 
In such operating system, the resources are allocated comfortably to the competing processes in a 
reasonable manner which results in a high throughput.  
 
Examples : OS/2 for high-end PCs, UNIX, MVS, etc. 

Multitasking and Multithreading Operating System 

These operating systems have the capability to execute more than one task concurrently on a 
computer system having a single CPU. In these operating systems, CPU switches from one task to 
another so quickly that it gives the illusion to the user of executing all the programs (or tasks) at the 
same time. 
 
Multithreading permits different portions of a single program to run concurrently and this it is having 
the ability of an operating system to execute different parts of a program (called threads) 
simultaneously. It requires the programmer to design the program so carefully that all the threads can 
run at the same time without interfering with each other. 
 
Examples : Windows 95/98, Windows NT, OS/2, etc.  

Real-time Operating Systems (RTOS) 

Real-time operating systems are used to control machinery, scientific instruments and industrial 
systems.  
 
These operating systems have the following peculiar characteristics: 

 Fast response time 

 Feedback mechanism 
 Reliability 

A primary objective of real-time operating systems is to provide quick response-times, and thus meet 
the scheduling deadlines. In the design of these operating systems, user-convenience and resource 
utilisation are of secondary concern. 
 
These operating systems must be designed in such a manner that response-time to the external-
stimulus is very immediate as the same are designed for the purpose of controlling and monitoring of 
external activities with timing constraints.  
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Such applications include : 
 

 Industrial Control 

 Telephone Switching Equipments 

 Flight-Control 
 Real-time Simulators 

 Few Military Applications 
        etc. 
 
Examples: 
 
Some examples of real time operating systems are: 
 

 BLMX (Board-Level Multitasking eXecutive) 
 BSO/RTOS (Boston Systems Office/ Real-time Operating System) 

 CCP (Communication Control Program) Operating System for IBM System/3 

 iRMX (Intel’s 8086 family Real-time Multitasking Executive) Operating System 

 DMERT (Duplex Multiple Environment Real-time) Operating System 
      etc. 

Distributed Operating Systems 

A distributed operating system governs the operation of a distributed computer system and provides a 
virtual machine abstraction to its users. The key objective of a distributed operating system is 
transparency. Ideally, component and resource distribution should be hidden from users and 
application programs unless they explicitly demand otherwise. 
 
The added services necessary for pooling of shared system resources include: 
 

 Global naming 

 Distributed file system, and 

 Facilities for distribution of computations, such as inter-node process communication 
and remote procedure calls. 

Embedded Operating System 

Embedded operating systems are mainly executed on computers that control devices. These devices 
are mobile phones, TV sets etc. These systems consist of circuits and 32-bit microprocessors that 
control the functioning of various operations.  
 
     Apart from the above main criterion for classification of operating systems, there will be other 
criterion as well, like basing on whether it is open code or not and whether it is available for free and 
similar.  
 
 
Fig. 1.4 shows widely used operating systems in the market.  
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Fig. 1.4: Widely used OS 

 

 

 

SUMMARY OF THE LESSON 
 
You learnt the following in this lesson: 

 The software acts as an interface between the user and the computer or a software can be 
defined as a complete set of instructions written by the programmer which enables the 
computer to obtain the solution to a problem.  

 There are different types of computer software such as Programming Software, System 
Software and Application Software 

 An application package or application program is the software that has been written to 
process or perform specific job.  

 Operating System (OS) is a collection of software written to provide the fundamental 
instructions that a computer needs to manage resources, such as memory, the file system, and 
processes.  

 The  control programs consist of Supervisor Programs, Job Control Programs and 
Input/Output Management Program 

 Windows Explorer displays the hierarchical structure of files, folders, and drives on your 
computer. It also shows any network drives that have been mapped to drive letters on your 
computer.  

 Both in Windows 7 and Windows 8, the Print Management console is part of Administrative 
Tools.  

 The Control Panel is a part of the Microsoft Windows graphical user interface which allows 
users to view and manipulate basic system settings and controls via applets, such as adding 
hardware, adding and removing software, controlling user accounts, and changing 
accessibility options. 
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SELF ASSESSMENT QUESTIONS AND EXERCISES 
 

1.  Differentiate between application and system software. 
2.  What is meant by GUI ? What are the important features of GUI ? Explain. 
3.  What are various components of GUI ? Explain.  
4.  What is a computer software ? 
5.  What is an operating system ? 
6.  Discuss the important functions of an operating system. 
7.  What is a bootstrap program ? 
8.  What is a File Manager ? Outline its responsibilities. 
9.  Is word-processing package a system software ? Justify your answer. 
10.  Discuss the features of an integrated package. 
11.  What are advantages of Windows environment ? 
12.  Enumerate functions of a monitor program. 
13.  Chart the family of operating system. 
14.  What are main features of Windows operating system? 
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CHAPTER - 2 
 

COMPUTER APPLICATIONS 
 

OBJECTIVES OF THIS LESSON 
 
This lesson is aimed to make you understand the use of computers in different walks of life. Though 
there are several computer applications but readers will be able to understand the use of computers in 
certain areas as under: 

 Computer applications in education and uses of computers in education 

 How computers may assist teachers and also explains computer-based teaching and learning 

 Computer applications in commerce and marketing, concept of marketing, business 
processes, e-commerce 

 CAD (computer aided design), CAM (computer aided manufacturing) and Simulations  

 Computer applications in management, functions of management and use of IT in 
management 

 
STRUCTURE OF THIS LESSON 

 
2.1 Introduction 
2.2 Computer Applications in Education 

2.2.1 Uses of Computers in Education 
2.2.2 Assistance to Teachers 
2.2.3  Computer-Based Teaching and Learning 

2.3 Computer Applications in Commerce and Marketing 
2.3.1 Marketing 
2.3.2 Business Processes 
2.3.3 E-Commerce 
2.3.4 Industry 
2.3.5 Robots 
2.3.6 CAD (Computer Aided Design) 
2.3.7 CAM (Computer Aided Manufacturing) 
2.3.8 Simulations 

2.4 Computer Applications in Management 
2.4.1 Functions of Management 
2.4.2 Use of IT in Management 

 

Summary of the Lesson 

Self Assessment Questions and Exercises 

 

2.1 INTRODUCTION 
 
Computers have become an essential part of modern human life. Owing to the widespread use of 
computers in every sphere, Life in today’s world would be unimaginable without computers. 
Computers have made human lives better and happier. There are endless uses of computer in different 
fields of work. 
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Computers are used in so many fields in our daily life. From Engineers to Doctors, Students, 
Teachers, and Government Organization they all use computers to perform specific tasks, for 
entertainment or just to finish office work. Computers have made our life easier. With greater 
precision and accuracy and less time taking computers can do a lot in short time while that task can 
take a lot of time while doing manually. Computers have taken industries and businesses to a whole 
new level. They are used at Home for work and entertainment purposes, at Office, in hospitals, in 
government organizations.  
 

2.2 COMPUTER APPLICATIONS IN EDUCATION 
 
The science and technology has been changing our life ever since its inception. Especially the greatest 
invention of human mind that most of the times defeat the human mind itself, i.e. the computer has 
brought out enormous changes to our society. Its contribution towards education sector has been truly 
marvellous.  
 
Computers have taken the education systems in the entire world to a different level altogether. It is 
now used in education sector in various ways and has changed the way it earlier looked to a  great 
degree.  
 
2.2.1 Uses of Computers in Education 
 
Following are few significant uses of computers in education: 

 

1. Effective Classroom Teaching and Learning 
 
The traditional classes have become modern and high-tech with the advent of computers. Students 
now see multimedia presentations, clips, images, etc. with the help of computers. This gives them a 
better experience of education as compared to the monotonous blackboard teaching. This way, the 
power of students to remember or recollect the taught concepts increases as the classroom learning 
becomes interesting.   

 

2. Online and Distance Learning 

 
Computers not only strengthen the traditional education system but also provide a new mode of 
pursuing educational courses and degrees. This mode is called as online distance learning mode of 
education. Through this mode a student can pursue a course, degree or training sitting at home with 
the help of a computer and internet connection. The curriculum of these online courses is similar to 
the traditional mode of pursuing the same. Online education system offers several benefits to the 
students which they can’t avail in traditional education system. This is the reason why millions of 
people are attracted to online education as of today and this count will only increase day by day.     

 
3. Improved Research Work 

 
Computers help students of schools, colleges and universities in their research work. Gone are the 
days when students would go to libraries, and other Knowledge processing units to complete their 
research work. With the help of computers in network society students now pursue their research 
work with ease and get ample amount of information for the same with easy clicks.    

 

 
 

 

4. New Areas of Education 
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Computers not only are useful in education sector but are also the reason for some fields of education.  
There are several educational courses that exist because of the computers. Some of these courses 
are IT training, web designing, hardware and networking, etc. Students pursuing these courses have 
bright future ahead as the computers have actually become the need of today.    

 

5. Scaling Up Education 
Education today is no more confined to the walls of a classroom. It has rather gone global. Students, 
with the help of computers, interact with students from all over the world. They discuss and deliberate 
on various topics of common interests, brainstorm with international students and seek advice of 
international teachers and researchers. Indeed computers have armed the education field with some 
great features. 
 

2.2.2 Assistance to Teachers 
 
Computers are helping the teachers in the following areas: 

a. Classification of pupils: Computers help in classification of children according to their 

abilities and evaluating their performance. 

b. Preparing time-table: Computers help in preparing time-table, schedules, etc. 

c. Maintenance of progress cards: Computers maintain progress cards and preserve them 

efficiently and confidentially.  

d. Tutorial and dialogue: Computer can play effectively the role of the tutor. It helps the 

teacher in engaging students in tutorial work. There is tutorial interaction and dialogue. 

e. Education to physically challenged: Computers can be used in providing education to 

physically challenged people by several means. 

f. Repetition: A lesson if not understood once can be repeated number of times and thoroughly 

understood by even an average student. Computer can work according to the tune of the 

student. 

g. Guidance: Computer helps the teacher in providing information/data for guidance and 

reference. 

h. Immediate feedback: Computers helps the teacher in providing immediate feedback to 

students for better interaction and motivation.  

i.  Problem-solving and creativity: Computers can be used to develop problem-solving ability 

and creativity among the students. 

j.  Laboratory and practical work: Computers can supplement laboratory and practical work 

especially in science and technology subject. 

k. Training through stimulate techniques: The computer can be used to give training to the 

students through stimulated and gaming techniques. 

2.2.3  Computer-Based Teaching and Learning 
 
Computers are used to provide the methods of teaching in different ways. There are number of 
methods in which educational institutions can use computer to educate the students. Much computer-
based educational software are available, which students can learn to read, to count, or to speak a 
foreign language. Software that combines the thrills of games with real information content is 
becoming most popular. Some organizations are using information technology in their employee 
training programs. 
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Computer Aided Learning (CAL) 
 
Computer Aided Learning could be described as the use of information technology to assist in the 
teaching and enhance learning process. Information technology may be able to aid us in reducing the 
time spent on creation and maintenance of teaching materials (power point presentations, Lectures in 
word documents, Flash media files etc). It is also reducing the administrative load associated with 
teaching and research. 

 

Computer Based Training (CBT) 
 
Computer based training is a difficult term to adequately define because it encompasses various 
modes of instruction and has evolved from the simplest definition, an interactive learning experience 
between the learner and computer in which the computer provides the majority of the stimulus, the 
learner must respond, and the computer analyzes the response and provides feedback to the learner.  
 
Computer-based training is about using computers to help train people. It is not necessarily about 
training people to use computers. Computer based training works, compared with traditional 
techniques; it can bring many additional benefits to any organization, their training department and 
their students. For example: 

 Students can readily acquire new skills at their own pace and at times that do not conflict 
with their work schedules. 

 Training times can usually be reduced. 

 Retention of course material is usually greater. 

 Interactive, visually stimulating, easily absorbed and easily available material encourages 
students to undertake training.  

 Planning and timetabling problems can be reduced or eliminated. 

 Essential skills can be taught and refreshed whenever and whenever needed. 

 The quality and consistency of the training material of students, locally or at remote 
places. 

 Timely and high quality training on demand leads to increased efficiency. 
             
Compared to traditional classroom training methods, students using computer based training absorb 
similar material faster and retain more of the information they are taught. CBT is a low cost solution 
for educating people. You can train a large number of people easily.  
 
Benefits of CBT 
 
Some benefits of CBT are as follows: 

1. The students can learn new skills at their own pace. They can easily acquire knowledge in 
any available time of their own choice. 

2. Training time can be reduced. 
3. Training materials are interactive and easy to learn. It encourages students to learn the topic. 
4. Planning and timing problems are reduced or eliminated. 
5. The skills can be taught at any time and at any place. 
6. It is very cost effective way to train a large number of students. 
7. Training videos and audios are available at affordable prices. 

 
Computer Aided Learning (CAL) 
Computer aided learning is the process of using information technology to help teaching and enhance 
the learning process. The use of computer can reduce the time that is spent on preparing teaching 
material. It can also reduce the administrative load of teaching and research. The use of multimedia 
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projector and PowerPoint presentations has improved the quality of teaching. It has also helped the 
learning process. 

 
Distance Learning 
 
Distance learning is a new learning methodology. Computer plays the key role in this kind of 
learning. Many institutes are providing distance learning programs. The student does not need to 
come to the institute. The institute provides the reading material and the student attends virtual 
classroom. In virtual classroom, the teacher delivers lecture at his own workplace. The student can 
attend the lecture at home by connecting to a network. The student can also ask questions to the 
teacher. 

 
Online Examination 
 
The trend of online examination is becoming popular. Different examination like GRE, GMAT and 
SAT are conducted online all over the world. The questions are marked by computer. It minimizes the 
chance of mistakes. It also enables to announce the result in time. 
 

2.3 COMPUTER APPLICATIONS IN COMMERCE AND MARKETING 

 
The use of computer technology in business provides many facilities. Businessmen are using 
computers to interact with their customers anywhere in the world. Many business tasks are performed 
more quickly and efficiently. Computers also help them to reduce the overall cost of their business. 
Computer can be used in business in the following ways. 

 

2.3.1 Marketing 
 
An organization can use computers for marketing their products. Marketing applications provide 
information about the products to customers. Computer is also used to manage distribution system, 
advertising and selling activities. It can also be used in deciding pricing strategies. Companies can 
know more about their customers and their needs and requirements etc. 

 
Marketing applications provide information about the organization’s products, its distribution system, 
its advertising and personal selling activities, and its pricing strategies. Marketing applications help 
managers to develop strategies that combine the four major elements of marketing: Products, 
Promotions, Place and Price. 
 
Marketing is the process by which goods are sold and purchased. The aim of  
marketing is to acquire, retain, and satisfy customers. Modern marketing has 
evolved into a complex and diverse field. This field includes a wide variety of 
special functions such as advertising, mail-order business, public relations, 
retailing and merchandising, sales, market research, and pricing of goods. 
 
Computers play a significant role in inventory control, processing and handling orders, 
communication between satelite companies in an organization, design and production of goods,  
manufacturing, product and market analysis, advertising, producing the company 
newsletter, and in some cases, complete control of company operations. 
 
In today's extremely competitive business environment businesses are searching for ways to improve 
profitability and to maintain their position in the marketplace. As competition becomes more intense 
the formula for success becomes more difficult.  
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Two particular things have greatly aided companies in their quests to accomplish these goals. These 
are : 

a) CAD/CAM and 

b) World Wide Web. 

CAD/CAM 
 
An important program has aided companies all over the world. Computer-aided design and computer-
aided manufacturing (CAD/CAM) is the integration of two technologies. It has often been called the 
new industrial revolution. In CAD, engineers and designers use specialized computer software to 
create models that represent characteristics of objects. These models are analyzed by computer and 
redesigned as necessary. This allows companies needed flexibility in 
studying different and daring designs without the high costs of building and testing actual models, 
saving millions of dollars. In CAM, designers and engineers use computers for planning 
manufacturing processes, testing finished parts, controlling manufacturing operations, and managing 
entire plants. CAM is linked to CAD through a database that is shared by design and manufacturing 
engineers. 
 
The major applications of CAD/CAM are mechanical design and electronic design. Computer-aided 
mechanical design is usually done with automated drafting programs that use interactive computer 
graphics. Information is entered into the computer to create basic elements such as circles, lines, and 
points. Elements can be rotated, mirrored, moved, and scaled, and users can zoom in on details. 
Computerized drafting is quicker and more accurate than manual 
drafting. It makes modifications much easier. 
 
Desktop manufacturing enables a designer to construct a model directly from data which is stored in 
computer memory. These software programs help designers to consider both function and 
manufacturing consequences at early stages, when designs are easily modified. 
 
More and more manufacturing businesses are integrating CAD/CAM with other aspects of 
production, including inventory tracking, scheduling, and marketing. This idea, known as computer-
integrated manufacturing (CIM), speeds processing of orders, adds to effective materials 
management, and creates considerable cost savings. 
 

World Wide Web 
 
The World Wide Web is a hypertext based information service. It provides access to multimedia, 
complex documents, and databases. The Web is one of the most effective vehicles to provide 
information because of its visual impact and advanced features. It can be used as a complete 
presentation media for a company's corporate information or information on all of its products and 
services. 
 
The recent growth of the world wide web (WWW) has opened up new markets and shattered 
boundaries to selling to a worldwide audience. For marketers the world wide web can be used to 
create a client base, for product and market analysis, rapid information access, wide scale information 
dissemination, rapid communication, cost-effective document transfers, expert advice and help, 
recruiting new employees, peer communications, and new business opportunities. The usefulness of 
the Internet or WWW depends directly on the products or services of each business. There are 
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different benefits depending upon the type of business and whether you are a supplier, retailer, or 
distributor.  
 
 

2.3.2 Business Processes 
 
In every organization there are major business processes that provide the critical tasks such that 
customer bills, analyzing sales of various products in different locations etc. in business, computers 
are used as given: 
 

a) Stock Exchange 

Stock markets around the world are in transition. Brokers interconnected through a data 
communication network submit and receive bids using their computer workstations or 
interconnected computer display screens, where brokers match buyers with sellers, so that 
neither trading floor nor slips of paper are necessary. 

b) Banks 

Computerized banking have several benefits such as save the time and convenience for 
customer. International banking and the abilities to handle trading in multiple currencies are 
critical for international trade. The cheques are read by MICR (Magnetic Ink Character 
Reader). Banks use mainframe computer to maintain their customer accounts by dealing with 
the transaction generated as a result of withdrawals and deposits.  

 

c) Departmental Store 

People at the store level, cashiers enter sales data into sale terminals by waving a bar code 
scanner across a package’s bar-coded prices and stock numbers. Bar codes are read by bar 
code readers, photoelectric scanners that translate the bar code symbols into digital forms. 
The price of a particular item is set with the store’s computer and appears on the sales-clerk’s 
point of sale terminal and on our receipt. Store and department manager who received report 
of store and department sales and inventory levels are indirect end users. Record of sales are 
input to the store’s computer and used for accounting, restocking store inventory, and 
weeding out products that sell well.  A security VCR (video cassette recorder) is widely used 
in department stores and other locations where aesthetics are priority. It is virtually 
impossible to tell where the camera is pointed, which makes it difficult for would-be camera 
avoiders to stay out of the camera’s view range; that are equipped with a camera, and lens can 
be augmented with dummy cameras. VCRs use the tapes, hook up the same way, and have all 
of the standard features of today’s consumer VCRs. Most importantly, they are just as easy to 
use. Security cameras are everywhere these days and the reason is quite clear; there is simply 
no better way to monitor home or business operations and ensures safety. 

 
d) Office Automation 

 Office Automation (OA) refers to the movements toward automating office tasks. An office 
where workers performs different tasks. The management and administrative tasks performed 
in an office five general categories of activities like decision-making, data manipulation, 
document handling, communication, and storage. Offices have used advance computer 
technologies to perform various tasks in an office system such as for document management 
system, message handling system, and office support systems. 
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e) Document Management System (DMS) 

DMS include word processing, desktop publishing, reprographic, image processing, and 
archival storage applications. Word processing enable documents to be created and edited 
electronically as well as help to produce high quality memos, letters, proposals, reports, 
newsletters and brochures etc. which are used to send business community. Desktop 
publishing enables to make document in attractive form by the use of photos, artwork, 
graphical illustrations etc. spreadsheet is software package used to create a table of columns 
and rows used by people responsible for tracking revenues, expenses, profits, loses, statistical, 
mathematical and logical processing etc. Reprographics is the process of reproducing 
multiple copies of a document. Image processing allow document to be scanned and stored in 
image oriented data bases. 

f) Message-handling system 

It enables to send messages or documents from one location to other location through 
facsimile (FAX), electronic-mail (E-Mail), Voice Mail etc. 
 

g) Office Support System 

It enables to coordinate and manage the activities of work group. Groupware and desktop 
organizers are some examples of office support systems. 

2.3.3 E-Commerce 
 
E-commerce (electronic commerce) describes buying, selling, and exchanging of products, services, 
and information via computer network. The term e-commerce describes transactions conducted 
between business partners. There are many applications of e-commerce, such as home banking, 
shopping in electronic malls, buying stocks, finding a job, conducting an auction, collaborating 
electronically with business partners around the globe, marketing & advertising and providing 
customer service.  
 
There are several types e-commerce like collaborative commerce, business to commerce, consumer to 
commerce, and Mobile commerce etc. Mobile satellite communications also promise to extend the 
global reach of voice, data and other services.  
 
The following services of e-commerce are used most frequently in e-business. 
 

a) Electronic Mail (E-mail) 

The e-mail is a service that transports text messages (with attachments of videos, audio, 
documents) from sender to one or more receivers via computer. Voice mail systems capture, 
store, and transmit spoken messages. 
 

b) Video Conferencing 

Video conferencing is a type of conferencing in which video transmission over networks. It is 
an advance form of teleconferencing. Video conferencing should provide a complete 
simulation of a normal meeting environment, enabling both parties to see, hear and present 
material, just as if they were in the same room. It can speed up business process and 
procedures in the same way that the fax and e-mail have revolutionized the way we share 
information. Tangible benefits are most easily related to actual cost savings. The most 
obvious quantifiable saving is the cost of travel and the cost of the time wasted during travel.  
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c) Electronic Shopping (E-Shopping) 

Almost all businesses now have website that allow Internet users to buy their goods or 
services. Shopping can take place using a computer at home, from work or at a cyber café and 
e-shop can be anywhere in the world working 24hours a day. 
 

d) Electronic Banking 

An electronic banking is also known as cyber-banking or online includes various banking 
activities conducted from home, a business, or on the road instead of a physical bank 
location. 

2.3.4 Industry 
 
Computers are used to control manufacturing system and continuous running of the machinery. These 
are also help in monitoring temperature, pressure, and also check the quality and accuracy, 
measurement needed in the manufacturing process. 

 
2.3.5 Robots 

 
A robot is an automatic programmable machine that moves and performs mechanical tasks. Robots 
are used in hundreds of applications from assembling and spray-painting cars, carrying out 
maintenance on overhead power cables, to testing blood samples, outer space experimental programs, 
in artificial satellites, and radioactive environments etc. robots can work in environment that are 
hazardous to humans, it can perform repetitive and boring task continuously without a break at high 
level of accuracy than human. 
 

2.3.6 CAD (Computer Aided Design) 
 
CAD (Computer Aided Design) are used for display designs and build production prototypes in 
software, test them as a computer object according to following given parameters: 

 Compile Parts and quantities lists. 

 Outline production and assembly procedures 

Transmit the final different applications some of them like designing new car or aircraft, bridge and 
building. Making changes to a design requires a large number of complex calculations. A CAD 
system needs a high resolution monitors, input devices (mouse, keyboard, graphic tables, and 
scanners etc) and output devices (printers and plotters). CAD use often has the capability of 
displaying a three dimensional object and speedily rotating it in any direction using controls on the 
keyboard. 

 

2.3.7 CAM (Computer Aided Manufacturing) 

 
CAM (Computer Aided Manufacturing) is used to control all the part of a manufacturing process. 
CAM software uses digital design output, such as that from a CAD system, to directly control 
production machinery. CAM systems are manufactured following goods. 
 

 Product can be made very accurately and consistently.  

 Around the clock production is much cheaper. 

 A product’s design can be modified without the need of bringing production to a computer 

standstill.  
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2.3.8 Simulations 
 
A computer simulation is a special type of computer model, which recreates a system that might exist 
outside the computer. Simulations are often used to train people how to deal with situations that are 
too difficult, expensive or dangerous to recreate and practice using for real. For example a flight 
simulation, which is used to train, pilots how to deal with situation that would be expensive and 
dangerous to practice using a real aircraft. A flight simulator consists of a working replica of the 
flight deck of an airplane. 
 

2.4 COMPUTER APPLICATIONS IN MANAGEMENT 
 
In every business, a computer is an essential tool for running the day-to-day operations, enhancing 
productivity and communicating with customers, suppliers and the public. Managers use computers 
for a variety of reasons, including keeping their teams on track, budgeting and planning projects, 
monitoring inventory and preparing documents, proposals and presentations. 
 

2.4.1 Functions of Management 
 
Effective management and leadership involve creative problem solving, motivating employees and 
making sure the organization accomplishes objectives and goals. There are five functions of 
management and leadership:  

 planning,  

 organizing,  

 staffing,  

 coordinating and  

 controlling.  

These functions separate the management process from other business functions such as marketing, 
accounting and finance. 
 

a) Planning 

 

The planning function of management controls all the planning that allows the organization to 

run smoothly. Planning involves defining a goal and determining the most effective course of 

action needed to reach that goal. Typically, planning involves flexibility, as the planner must 

coordinate with all levels of management and leadership in the organization. Planning also 

involves knowledge of the company’s resources and the future objectives of the business. 

b) Organizing 

 

The organizing function of leadership controls the overall structure of the company. The 

organizational structure is the foundation of a company; without this structure, the day-to-day 

operation of the business becomes difficult and unsuccessful. Organizing involves 

designating tasks and responsibilities to employees with the specific skill sets needed to 

complete the tasks. Organizing also involves developing the organizational structure and 

chain of command within the company.  
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c) Staffing 

 

The staffing function of management controls all recruitment and personnel needs of the 

organization. The main purpose of staffing is to hire the right people for the right jobs to 

achieve the objectives of the organization. Staffing involves more than just recruitment; 

staffing also encompasses training and development, performance appraisals, promotions and 

transfers. Without the staffing function, the business would fail because the business would 

not be properly staffed to meet its goals. 

d) Coordinating 

 

The coordinating function of leadership controls all the organizing, planning and staffing 

activities of the company and ensures all activities function together for the good of the 

organization. Coordinating typically takes place in meetings and other planning sessions with 

the department heads of the company to ensure all departments are on the same page in terms 

of objectives and goals. Coordinating involves communication, supervision and direction by 

management. 

e) Controlling 

 

The controlling function of management is useful for ensuring all other functions of the 

organization are in place and are operating successfully. Controlling involves establishing 

performance standards and monitoring the output of employees to ensure each employee’s 

performance meets those standards. The controlling process often leads to the identification 

of situations and problems that need to be addressed by creating new performance standards. 

The level of performance affects the success of all aspects of the organization.  
2.4.2 Use of IT in Management 
 
The use of computers and Information Technology (IT)-based systems in mainstream businesses has 
redefined workplace practices, operational metrics and business models. Top management and key 
business executives have been able to leverage the various capabilities of computer-based systems 
and productivity software technologies to get a better handle on business operations, channelize 
employee productivity and address strategic goals. The importance of computers in management 
cannot be overstated. 
 

Organisations that understand the strategic potential of information technology (IT) integrate it into 
everything they do. Their IT investments advance their business goals and work seamlessly with 
current people and processes. 
 
Managers need to understand not only the basic functions of the corporate software tools used in the 
office but also the Internet and other external computing tools that can improve the way they manage 
their departments. 
 
1. Business Planning 

 
Business planning can take up a lot of a manager's time, but computer programs make it easier. 
From using email programs like Outlook or Google Mail to set appointments, tasks and 
deadlines to using financial tools to develop budgets and project proposals, using computers to 
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plan the day-to-day activities of a business is essential. Managers also use the Internet to 
research their industries, the competition and to look for ideas to help them create plans to 
engage customers, win more business and succeed in the competitive world of business. 
 

2.    Record Keeping 

 
Managers keep track of a lot of information that is vital to the company's success. From 
customer records to financial records to employee records, the data a company has to store are 
seemingly endless. Using computers to store and manage documents, files and records reduces 
the amount of physical storage a company needs and also allows managers to have easy access to 
their files using simple document search methods. Additionally, by keeping records, managers 
can easily share information about an employee's history and job performance with other 
managers in the company. 

 

3.    Communication 

 
One of the most common uses for computers in business is communication. Communication is 
essential not only between employees but with customers as well. Many customer service 
departments use computers to log service issues and make a record of their resolutions. Using 
email and instant messaging programs allows employees to gather information from one another 
that they need to complete their jobs. It also allows managers to delegate work tasks and follow 
up on projects. 

 

Computer networks connected over an intranet-based system or Web-based environment can 
communicate with one another. In modern businesses, business owners and enterprise decision 
makers need employees to communicate instantly with each other, collaborate and share files, 
information and relevant documents quickly in order to execute work-related tasks and pursuits. 
Use of e-mail systems, instant messaging tools and more recently social networking applications 
has also enhanced swifter communication with business partners, customers, suppliers and other 
key external stakeholders. 

 

4. Transactions Management 

Organizations and businesses perform thousands of transactions at varied customer and business 
partner –facing interfaces. Purchase managers, inventory system professionals and accounts and 
financial personnel need to keep track of invoices, purchase orders, payment gateways on 
organization websites and all transactions at the operational level.  
 
Computer systems integrate varied transaction processes and activities and facilitate real-time 
tracking of transactions. IT applications speed the process of transaction activities and help in 
calculations, generation of accurate summaries and reports. 

 

5. Decision Making 

Computers, IT systems and allied software programs help companies to classify, arrange, 
systematize and analyze information. Use of CRM solutions, Enterprise Resource Planning 
(ERP) systems, Management Information Systems (MIS) and database systems enable 
companies to operationally manage business processes and functional areas. Market intelligence, 
sales reports and customer insights generated from such systems aid business managers, top 
management and project heads in important decision making processes. 
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Document Preparation 

 
For creating spreadsheets, presentations, memos and other corporate documents, computers are 
essential in business. Managers need to have a basic understanding of common workplace 
productivity software such as Microsoft Office, but specialized industries such as advertising and 
marketing also require managers to work with more advanced programs like Adobe Photoshop 
and Illustrator to create visual materials for clients. 

6. Improve Productivity 

One of the primary purposes of deploying large-scale computer systems, software, networking 
and IT tools is to gain productivity on all levels in an organization. All departments, 
manufacturing and production facilities and offshore centers should be able to leverage the 
capabilities and of modern IT systems and technologies and function more effectively and 
efficiently. Used strategically, computers streamline employee workflows, operational activities 
and functional processes, ensure better control in business management and impact the bottom-
line. 
 

7. Role in Innovation Management 

As the global economic crisis forces businesses to operate leaner, competition continues to 
accelerate at lightning speed. Simultaneously, consumers are clamping down on discretionary 
spending and demanding more value and options in the purchases they make. 
 
Innovation management — or finding and realizing new sources of value — is key to helping 
businesses keep up with this constantly changing economic and competitive landscape. 
 
With careful thought, planning, and ingenuity, IT can help businesses move from a closed 
innovation model to an open one, playing a pivotal role in capturing an increasingly elusive 
competitive advantage. 

 Innovation management is a technology matter 

 Innovation management—the long and short of it 

 Harnessing technology for innovation is a strategy that makes sense 

SUMMARY OF THE LESSON 
 
You learnt the following in this lesson: 

 Computers are used in so many fields in our daily life. From Engineers to Doctors, Students, 
Teachers, and Government Organization they all use computers to perform specific tasks, for 
entertainment or just to finish office work. Computers have made our life easier.  

 Computers have taken the education systems in the entire world to a different level 
altogether. It is now used in education sector in various ways and has changed the way it 
earlier looked to a great degree.  

 The traditional classes have become modern and high-tech with the advent of computers. 
Students now see multimedia presentations, clips, images, etc. with the help of computers.  

 Computers not only strengthen the traditional education system but also provide a new mode 
of pursuing educational courses and degrees. This mode is called as online distance learning 

mode of education.  

 Computers help students of schools, colleges and universities in their research work 

 Computers not only are useful in education sector but are also the reason for some fields of 
education.  
 

Remarks 



 Education today is no more confined to the walls of a classroom. It has rather gone global.  

 Computers are helping the teachers in the several areas classification of pupils, preparing 
time-table, maintenance of progress cards, tutorial and dialogue, and education to physically 
challenged. 

 Computers are used to provide the methods of teaching in different ways.  
 Computer Aided Learning could be described as the use of information technology to assist 

in the teaching and enhance learning process 

 Computer-based training is about using computers to help train people. It is not necessarily 
about training people to use computers.  

 Compared to traditional classroom training methods, students using computer based training 
absorb similar material faster and retain more of the information they are taught.  

 Computer aided learning is the process of using information technology to help teaching and 
enhance the learning process.  

 Distance learning is a new learning methodology. Computer plays the key role in this kind of 
learning. Many institutes are providing distance learning programs.  

 An organization can use computers for marketing their products. Marketing applications 
provide information about the products to customers 

 Marketing is the process by which goods are sold and purchased. The aim of 
marketing is to acquire, retain, and satisfy customers.  

 In every organization there are major business processes that provide the critical tasks such 
that customer bills, analyzing sales of various products in different locations etc. in business 

 E-commerce (electronic commerce) describes buying, selling, and exchanging of products, 
services, and information via computer network. The term e-commerce describes transactions 
conducted between business partners.  

 CAM (Computer Aided Manufacturing) is used to control all the part of a manufacturing 
process. CAM software uses digital design output, such as that from a CAD system, to 
directly control production machinery.  

 A computer simulation is a special type of computer model, which recreates a system that 
might exist outside the computer.  

 In every business, a computer is an essential tool for running the day-to-day operations, 
enhancing productivity and communicating with customers, suppliers and the public.  

 There are five functions of management and leadership - planning, organizing, staffing, 
coordinating and controlling.  

SELF ASSESSMENT QUESTIONS AND EXERCISES 

1. What are computer applications in education? 
2. What are different uses of computers in education? 
3. How computers may be helpful to teachers?  
4. What is computer-based teaching (CBT)? What are its benefits? 
5. How computers may help in learning?  
6. What are computer applications in commerce? 
7. What is e-commerce? How is it useful? 
8. How computers help in marketing?  
9. What are business processes? 
10. What do you understand by CAD (computer aided design) and CAM (computer aided 

manufacturing)? 
11. What are Simulations?  
12. What are computer applications in management? 
13. What are major functions of management? 
14. Discuss the use of IT in management? 
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CHAPTER - 3 
 

WINDOWS OPERATING SYSTEM 
 

OBJECTIVES OF THIS LESSON 
 
This lesson is aimed to make you understand the basic concepts of windows. Readers will be able to 
understand the following: 

 Windows operating system, its common features, Windows Explorer. 

 Control Panel, Print Manager and other elements of Windows GUI 
 

 

STRUCTURE OF THIS LESSON 

 
3.1 Windows Operating System 

3.1.1 Common Features of Windows GUI 
3.1.2 Windows Explorer 
3.1.3 Print Manager and Installing Printers 
3.1.4 Control Panel 
3.1.5 Using Paint Brush 
3.1.6 Using Clipboard in Windows 
3.1.7 My Computer 

 
Summary of the Lesson 

Self Assessment Questions and Exercises 

 

 

3.1 WINDOWS OPERATING SYSTEM 
 

Microsoft Windows  (or simply Windows) is a metafamily of graphical operating 
systems developed, marketed, and sold by Microsoft. It consists of several families of operating 
systems, each of which cater to a certain sector of the computing industry.  

The Windows operating system is developed and maintained by Microsoft, the company founded by 
Bill Gates. The first version was released in 1985. Since then, it has grown significantly, and it now 
dominates the market. Windows uses a graphical user interface to make it easier for people to use 
their computers. The primary ways that people navigate are through icons on the desktop and the Start 
menu.  

As of April 2014, the most recent versions of Windows for personal computers, smartphones, server 
computers and embedded devices are respectively Windows 8.1, Windows Phone 8.1, Windows 
Server 2012 R2 and Windows Embedded 8. A specialized version of Windows runs on the Xbox 
One game console. 
The next version of Windows is Windows 10 and is currently available as a technical preview; it is 
set for release for phones, tablets, laptops, and PCs in late 2015. 
However, versions of Windows operating system with its date of release are provided in Table 3.1. 

 

Table 3.1: Windows Operating System Versions 
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Date Version 

1981 Sept.  Interface Manager 

1983 Windows was announced 

1985 Nov. Windows 1.0 for 8088 CPUs released 

1987 Dec. Windows 2.0 for 386 CPUs, up to 16 mbyte RAM addressable 

1988/89 Windows 2.1 for 286/386 

1990 Windows 3.0 

1992 April 3.1 (janus) includes MS-DOS 5.0 

1993 Nov. Windows for Workgroups 3.11 (snowball) rudimentarily networkable 

1995 Aug. Windows 95 4.0 Codename "Chicago" was released 

1996 Feb. Windows 95 Version A (OSR1) 

1996 Aug. Windows 95 (detroit) Version B (OSR2) first time with FAT-32 support 

1997 April Windows 95 Version B (OSR2.1) 

1997 Nov. Windows 95 Version C (OSR2.5) 

1998 June Windows 98 (memphis) about 5,000 bugs fixed 

1999 May Windows 98 SE (Second Edition) 

2000 Sept.  Windows Me (Millenium) 

1980 Aug. XENIX OS cooperation with SCO 

1982 Feb. XENIX 2.3 cooperation with SCO 

1983 April XENIX 3.0 cooperation with SCO 

1987 MS OS/2 1.0 cooperation with IBM 

1988 OS/2 1.1 cooperation with IBM 

1991 OS/2 1.3 cooperation with IBM 

1992 OS/2 2.0 cooperation with IBM 

1993 July 
Windows NT 3.1 & Advanced Server; 3.1 million lines of source code, 

supports HPFS 

1994 Sept.  
Windows NT 3.5 (daytona), Workstation and Server, with opengl and 

Netware client; 9 million lines of source code 

1995 May 
Windows NT 3.51, updae, transparent compression with NTFS file 

system, PCMCIA support, for Power-PCs available too 

1996 Aug. 
Windows NT 4.0 (cairo) 16 million lines of source code, no support for 

HPFS anymore 

1996 Windows NT Terminal Server Edition (hydra)  

1997 Windows NT Server 4.0 Enterprise Edition 

1998 Windows NT Server 4.0 Terminal Server Edition 

2000 Feb. 
Windows 2000, Windows version 5.0; 30 million lines of source code, 

about 10,000 bugs fixed 

2000 Sept.  2000 Datacenter Server 

2001 Oct. Windows XP (whistler), Windows version 5.1 

2002 Windows XP Media Center Edition, Windows XP Tablet PC Edition 

2003 April Windows Server 2003 version 5.2 (whistler server) 
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2006 Windows Vista, Windows version 6.0, Codename Longhorn (Client)  

2006 June Windows Compute Cluster Server 2003 (Windows CCS 2003)  

2008 Feb. Windows Server 2008 (Codename Longhorn) 

2007 July Windows Home Server 1.0 

2009 Oct. Windows 7 (Codename Vienna) 

2012 Oct. 26 Windows 8 

2013 Oct. 18 Windows 8.1 (Codename Blue) 

 

3.1.1 Common Features of Windows GUI 

 
Desktop view of GUI of Windows 7 Home Premium  is shown in Fig. 3.1. 

 

 
 

Fig. 3.1: Desktop View of Windows 7 Home Premium 

A present day GUI has the following common features:  

a) Pointing device(s): These allow users to point at different parts of the screen as well as can be 
used to initiate a command. Besides, these can also be used to manipulate objects on the 
screen by: 

 selecting objects on the screen 

 moving objects around the screen, or 

 merging several objects into another object 
Examples: Mouse, light pen, joystick, touch sensitive screen, touch pad and so on. 

b) Windows : It  graphically display the progress of the action initiated. When a screen is 
divided into several independent regions, each one of these is called a window. Each window 
can highlight results related to the action fired in the respective window.  

c) Switching capability : Windows system offers the switching capability from one application 
to another or for sharing of  data among various applications. 

d) Resizing and Movement : Windows system also support resizing as well as moving around 
feature of windows. 

e) Graphical Bit-mapped Displays : Bit-mapped display are made up of small pixels and offer a 
very high resolution. Bit-mapped displays have almost replaced character-based displays. Bit-
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mapped displays wonderful support graphic manipulation. This feature of these displays is  
also called WYSIWYG i.e. What You See Is What You Get. 

f) Functionality to support graphics along with height-parameters, color attributes, video-
attributes, etc. 

g) Icon : Icons provide a symbolic representation of any system-entity or user-defined object, 
etc.  such as file, folder, address, table, book, applications and so on. A folder icon consists a 
group of files or other folder icons. Double clicking on the folder icon causes a window to be 
opened displaying a list of icons and folder icons representing the folder's contents. 

h) Dialog box : Dialog box is used  to capture user information  or to present information to the 
user. Normally, a dialog box is displayed to get additional information. Dialog boxes are also 
used to indicate error messages in the form of alert boxes. Dialog boxes also use a wide range 
of screen control elements to communicate with the user. 

i) Check box : Such a box is used to capture the information intending confirmation pertaining 
to any kind of actions desired by the end-user.  

j) Sliders : These are used to show the relative position of the contents or to move to a different 
position. 

k) Desktop Metaphors : In desktop graphical metaphor, users are not aware of applications and 
they deal with files, folder, drawers, clipboard and an out-box. For example, merely clicking 
the mouse on an icon representing the Report cause word processor to get started and to load 
the report file automatically.  

l) Menus : The functionality on a GUI system must be arranged in the form of structured menus 
such as horizontal menus, pull-down menus, etc. From the menu, the end-user can select any 
operation of his choice such as File, Edit, Search, Tool and so on. Rather than remembering 
commands at each stage, a menu can be used to provide a list of items. Each menu element 
can be either a word or an icon representing a command or a function. Menu item can be 
invoked by moving the cursor on the menu item and selecting the item by clicking the mouse. 

 

3.1.2 Windows Explorer 

 
Windows Explorer displays the hierarchical structure of files, folders, and drives on your computer. It 
also shows any network drives that have been mapped to drive letters on your computer.  
 
Windows Explorer is automatically launched any time you open a folder in Windows  XP. 
 
Using Windows Explorer, you can copy, move, rename, and search for files and folders. For example, 
you can open a folder that contains a file you want to copy or move, and then drag the file to another 
folder or drive. 
 
There are other places in Windows where you can view and work with files and folders. My 
Documents is a convenient place to store documents, graphics, or other files you want to access 
quickly.  
 
You can also view My Network Places, which lists other computers that are connected to your local 
area network (LAN). When you delete files or folders from your hard disk, Windows places them in 
the Recycle Bin, where you can retrieve them, until you empty the Recycle Bin. Files or folders 
deleted from a floppy disk or a network drive are permanently deleted and are not sent to the Recycle 
Bin. 
 
To open Windows Explorer, click Start, point to All Programs , point to Accessories , and then 
click Windows Explorer.  
 

3.1.3 Print Manager and Installing Printers 
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Both in Windows 7 and Windows 8, the Print Management console is part of Administrative Tools. 
However, it is not available in all editions of Windows. Only users of Windows 7 Professional, 
Ultimate and Enterprise will be able to use it. In Windows 8 it is available in Windows 8 Pro and 
Enterprise. 
While a search for the term Print Management in Windows 7‘s Start Menu will return the appropriate 
result, doing the same in Windows 8‘s Start screen will not. That‘s why, to make sure you find it, it is 
best to open the Control Panel and go to System and Security -> Administrative Tools. 

 
Fig. 3.2: Administrative Tools Menu 

This will work both in Windows 7 and Windows 8. 
When you first launch Print Management, its window will look similar to the screenshot below. 
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Fig. 3.3: Print Management Menu 

Installing Printer in Windows 7 - Step by Step Guide 

 Click on Start and then click on ―Device & Printers‖ – Then you get the Printers page. 
 Then go top and find ―add a printer‖ menu, Click on ―add a printer―. 
 Now you got a printer setup wizard front of you and asking to ―how do you want to install 

your printer‖ with USB cable  (Local printer) or Wireless / Network. 
 Under Local printer you can Install printer with LPT port and with the USB cable. 
 Select the USB port and select ―USB001 (Virtual port for USB printer)‖ and then click 

on next. 
 Now in the next windows pick your appropriate drivers  for this particular printer. 
 After that you get your printer driver successfully installed 

 

3.1.4 Control Panel 
 
The Control Panel is a part of the Microsoft Windows graphical user interface which allows users to 
view and manipulate basic system settings  and controls via applets, such as adding hardware, adding 
and removing software, controlling user accounts, and changing accessibility options.  
 

To open the Control Panel, click the Start button on the taskbar and then click Control Panel on the 
Start menu. Windows 7 gives you three different views for looking at your computer‘s Control Panel: 
To switch views, click the View By drop-down button (labelled Category by default) in the upper-
right corner of the Control Panel and then choose one of the views from the button‘s drop-down 
menu. 
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Fig. 3.4: Control Panel Menu 
By default, the Control Panel is displayed in Category view, which is separated into eight categories, 
ranging from System and Security to Ease of Access. To open a window with the Control Panel 
options for any one of these categories, simply click the category‘s hyperlink.  

 

Fig. 3.5: Control Panel Menu 
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3.1.5 Using Paint Brush 
 
Paint formerly known as Paintbrush for Windows is a simple graphics painting program that has been 
included with almost all versions of Microsoft Windows since its first release. It is often referred to as 
MS Paint or Microsoft Paint.  
The program opens and saves files as Windows bitmap (24-bit, 256 color, 16 color, and monochrome, 
all with the .bmp extension), JPEG, GIF, PNG, and TIFF. The program can be in color mode or two-
color black-and-white, but there is no gray scale mode. For its simplicity, it rapidly became one of the 
most used applications in the early versions of Windows—introducing many to painting on a 
computer for the first time—and still has strong associations with the immediate usability of the old 
Windows workspace. 

Steps to Start the Paint Brush 
1).Click on the Start Button. 
2).Click Programs. 
3).Click Accessories. 
4).Click on Paint.  
 
Then you will screen as shown below: 

 

Fig. 3.6: Paint Screen 

Menus 
 
Four of the Paint menus—File, Edit, View and Help—are common to almost all Windows programs. 
Menus that are special to Windows Paint are Image and Colors. The menu of greatest interest is the 
Image Menu. 
 

 

Fig. 3.7: Paint Menu 

Toolbox 
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All the little grey boxes down the left are called the tools and together they make the toolbox. The 
individual tools will each be explained separately further down. Under the toolbox is a small area 
where you see different options according to which tool you‘re using.  
 

 

Fig. 3.8: Paint Toolbox 

Paste Options 
 
In this picture, with the selection tool active, you have a choice between paste opaque and paste 
transparent (selected, as you can tell by the dark background).  
 

 

Fig. 3.9: Paint Paste Options 

The Colour Palette 
 
Under the main window is the colour palette. The two squares set apart from the rest at the left end of 
the palette show the active colours; the colours presently in use. When you click on a colour in the 
palette with the left mouse button, that colour will be the primary or foreground colour, here shown as 
pink. The colour you click on with the right mouse button will be the secondary or background 
colour, here shown as white. 

3.1.6 Using Clipboard in Windows 

In Windows and other operating systems, the Clipboard is a short-term storage area for all kinds of 
information that you have copied from one place and you plan to use in another place. You can copy 
just about anything to the Clipboard: strings of text, images, video, files, folders, shortcuts, etc. 
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When you copy (or cut) something, it is stored in the Clipboard. When you copy (or cut) something 
else that piece of information overwrites the previous contents. This is because Windows provides 
support for a single clipboard transaction. 
When you paste the contents of the Clipboard, the contents remains available for further pasting 
operations. It is overwritten only when you copy or cut something else. 

What Can You Copy to the Clipboard? 

Just about anything that can be selected in Windows: text of all kinds, graphics, files (including 
shortcuts) or folders. 

What Can You Paste from the Clipboard? 

Pasting the contents of the Clipboard depends on where you want to perform the paste. For example, 
if you are working with text, you can paste text only in apps and programs that work with text. 
Following the same rule, you can paste graphics only in apps and programs that work with graphics, 
and so on. 
If the contents of the Clipboard cannot be pasted where you want to, it will not be pasted there but the 
contents of the Clipboard will remain intact. 

How to Manage the Clipboard in Windows? 

Windows XP had a Clipboard Viewer that allowed users to view the contents of the local clipboard, 
clear the clipboard or save copied and cut items. 
Unfortunately, this program was removed from Windows Vista and subsequent versions of Windows, 
including Windows 8.1. 
Therefore, if you want to view the contents of the clipboard and manage it, you must use third-party 
programs developed by companies other than Microsoft.  
 
Windows XP had clipbrd.exe, referred to as the Clipboard Viewer or the ClipBook Viewer, which 
could be used to see what was saved on your clipboard. If you try to search for this exe file in 
Windows Vista, Windows 7 or Windows 8, you will be unable to find clipbrd.exe. 
 
Clipboard in Windows 7 / 8 

 
In Windows XP this file was situated in C:\Windows\System32\clipbrd.exe. It is now missing as a 
part of the Windows 7 | 8 installation. You can try to copy it from a Windows XP installation, if you 
have access to it, and paste it in your System32 folder. In most cases this is known to work.  
 
Clipboard Viewer 
 
If you wish, you can download Windows Clipboard Viewer but if it does not work or if you are 
confronted with a message of sorts: Entry Point Not Found, then you may try to run it in Windows 
XP/SP2 compatibility mode and see if it works. 
 
The Windows Clipboard is very basic in nature and does not offer many features. As a result, 
many free Clipboard alternatives like ArchiveClipboard, Enhanced Clipboard 
Manager, CopyCat, Clipboardic, Orange Note, Ditto, Clipboard Magic, etc, are available on the 
Internet. 
 

3.1.7 My Computer 
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The ‗My Computer‘ icon gives us easy access to our hard drives, removable flash drives and other 
network-related locations. But if you‘re one who enjoys a clutter-free desktop, then maybe you can 
use this tweak to remove the many program and folder shortcuts on your desktop. 

 

Fig. 3.10: My Computer 

Here‘s a way to get more usefulness out of ―My Computer‖ by adding the shortcuts that you need to 
it. This also gives you quick access to the program or folder and works very well with Windows 
Explorer tabs tweak like Clover.  

 

 

SUMMARY OF THE LESSON 
 
You learnt the following in this lesson: 
 

 Operating System (OS) is a collection of software written to provide the fundamental 
instructions that a computer needs to manage resources, such as memory, the file system, and 
processes.  

 Windows Explorer displays the hierarchical structure of files, folders, and drives on your 
computer. It also shows any network drives that have been mapped to drive letters on your 
computer.  

 Both in Windows 7 and Windows 8, the Print Management console is part of Administrative 
Tools.  

 The Control Panel is a part of the Microsoft Windows graphical user interface which allows 
users to view and manipulate basic system settings and controls via applets, such as adding 
hardware, adding and removing software, controlling user accounts, and changing 
accessibility options. 

 Paint formerly known as Paintbrush for Windows is a simple graphics painting program that 
has been included with almost all versions of Microsoft Windows since its first release. It is 
often referred to as MS Paint or Microsoft Paint.  
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 In Windows and other operating systems, the Clipboard is a short-term storage area for all 
kinds of information that you have copied from one place and you plan to use in another 
place.  

 The ‗My Computer‘ icon gives us easy access to our hard drives, removable flash drives and 
other network-related locations.  
 

SELF ASSESSMENT QUESTIONS AND EXERCISES 

 
1.  What is an operating system ? 
2.  Discuss the important functions of an operating system. 
3.  What is a File Manager ? Outline its responsibilities. 
4.  Chart the family of operating system. 
5.  What is Windows operating system? List its important versions. 
6.  What is the purpose of a clipboard?  
7.  What is Print Manager? 
8.  What is ‗My Computer‘?  
9.  What is Paint program/Paint Brush? 
10.  What are main features of Windows operating system? 
11.  What is Control Panel? How is it useful? 
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CHAPTER - 4 
 

INTRODUCTION TO MICROSOFT EXCEL 

OBJECTIVES OF THIS LESSON 
MS-Excel is a spreadsheet package which organizes various types of data. It offers enormous 
features. This lesson is aimed to make you understand the following: 

 Introduction of MS Excel 

 Features of MS Excel 
 Basic concepts of MS- Excel i.e. Rows, Columns, Cell etc. 

 Applications of Spreadsheet 

 Various Menu and Toolbar options 

 Creating worksheet 

 Opening worksheet  

 Saving  worksheet 

 Basic operations on worksheet 
 

STRUCTURE OF THIS LESSON 

 
4.1  Introduction 
4.2  Features of Ms-Excel 
4.3  Applications of a Spreadsheet 
4.4  Starting Ms-Excel 
4.5  Basic Terms in Excel 
4.6  Ms- Excel Window Elements 
4.7  Menu 
4.7.1  File Menu 
4.7.2  Edit Menu 
4.7.3  View Menu 
4.7.4  Insert Menu 
4.7.5  Format Menu 
 4.7.6  Tools Menu 
 4.7.7  Data Menu 
 4.7.8  Windows Menu 

            4.7.9 Help Menu 
4.8  Creating, Opening and Saving Workbook/Worksheet 
4.8.1  Creating a New Workbook 
4.8.2  Opening a Workbook 
4.8.3  Saving a Workbook 
4.8.4  Closing a Workbook 

 4.9  Basic Operations on Worksheet 
 
Summary of the Lesson 
Self Assessment Questions and Exercises
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4.1 INTRODUCTION 

 
Microsoft Excel is a spreadsheet package, which organizes all types of data especially numerical data. 
It is a tool for not only storing or managing data but also analyzing and querying data. A spreadsheet 
offers considerable ease of performing such tasks by automating all arithmetic calculations and 
making it easier to change certain numerical values. Spreadsheet is a primary document which 
consists of cells that are organized into columns and rows.  Excel not only does accounts related work 
but it is cool graphical user interface and user friendliness, even while doing some sophisticated tasks.  
Working in spreadsheets saves a lot of time.    

4.2  FEATURES OF MS-EXCEL 
Some of the features of MS-Excel are: 

1. Data can be manipulated in tabular form. 

2. Excel contains workbooks, in which worksheets are present. Each worksheet consists of 256 

columns and 65536 rows. 

3. Data from excel can be exported to other compatible software. 

4. Excel supports charts and graphs for pictorial representation of data. 

5. Excel provides built-in functions to perform calculations. 

6. This spreadsheet package offers many features that helps to handle complex data like goal 

seek, what-if analysis. 

7. Allows to automate the work using macros. 

8. Support powerful printing features. 

9. Allows to sort the data on one or more columns.  

10. Provides features like autolist, find and replace etc for effective data entry. 

 

4.3  APPLICATIONS OF SPREADSHEET 
Some of the applications of spreadsheet are: 

1. Payroll management.  

2. Inventory management. 

3. Income statements preparation. 

4. Financial institution can use such spreadsheet packages to manage their receipts and 

payments. 

5. Budget control. 

6. Annual report of an organization 

7. Scientific Calculation. 

8. Educational Institutions use spreadsheet to keep the records of different students. 

9. Banking and other financial services. 

10. Cost- effective analysis. 

 

4.4  STARTING MS-EXCEL 
 Click on Start button 

 Select the option Programs 

 Click on Microsoft Excel 

MS-Excel window will appear 
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4.5  BASIC TERMS IN EXCEL 

 (a) ROWS 
All the rows are numbered numerically i.e. 1, 2, 3…. and so on. There are 65536 rows in 
each spreadsheet. We can insert a new row by clicking on insert menu. We can also do 
formatting on rows. 

 (b) COLUMNS 

All the Columns are labeled alphabetically i.e. A, B, C….. and so on. There are 256 
columns in each worksheet. We can change the width of column. We can also do 
formatting on columns. 

 (c) Cell 

         Intersection of a row and a column is called cell. It contains Text or Numbers. We can 
apply      
         formatting on cells. We can also insert or delete cells. The active cell has a dark outline.      
         When a cell is active, data can be typed into it.  

 

 

 (d) Range Of Cells 
        Many spreadsheet operations consists a range of cells instead of a single cell. A range of cells 
 may involve many cells and entering every individual cell address for performing an 
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operation on  them may be time taking. To resolve this problem, the concept of cell ranges is used. 
These are of  following types: 

1. Row Range: It includes a set of adjacent cells in the same row. For example, the range 

B5…D5 refers to the cells B5, C5 and D5. 

2. Column Range: It includes a set of adjacent cells in same column. For example, the range 

C5..C9 refers to the cells C5, C6, C7, C8, and C9. 

3. Block Range: It includes a set of adjacent cells in a rectangular group of cells. For example, 

the range B5.. D9 refers to the cells B5, B6, B7, B8,  B9, C5, C6, C7, C8, C9,D5, D6, D7, 

D8, and D9. 

 

 (e) Cell Contents 
              In spreadsheets, different types of data can be entered in a cell. The four commonly used 
types  of cell data are: 

1. Label: A label is any string of alphanumeric text. Label can be used to enter either 

alphanumeric values in cells, or descriptive data or titles to make the contents easier to 

understand. 

2. Numeric value : A numeric value is a number on which spreadsheet can perform calculations.  

3. Formula: A formula may include numbers, mathematical operators, mathematical functions 

supported by spreadsheet and cell addresses. 

4. Date and time : Date and/or time contents type in a spreadsheet are used to display the actual 

date and time. 

 

 (f) Cell Referencing 
Reference to a cell can be done in three ways: 

1. Relative referencing 

The copied formula presents the positional relationship among the cells and this type of 
referencing is called Relative referencing. For example, suppose the cell E5 contain the 
formula = B5+ C5 + D5. Excel provides the facility to copy the content of a cell or group 
of cells. If the formula in E5 is copied to E10, Excel copies it as B5 +C5 +D5. 

2. Absolute referencing  

Referring to the value in a cell rather than the position of the cell is called Absolute 
referencing. For example, suppose D5 contain the formula = C3*12. We wish to copy the 
formula to cell D6, such that it appears as =C3*12 in this cell. If C3 is taken as a relative 
address then the copy of the formula to the cell D6 will be C4*12.  
MS-Excel uses $ (dollar) symbol to distinguish absolute and relative referencing. To 
make the relative reference ―C3‖ as absolute ―$C$4‖ will have to be typed in formula in 
D5. So we type the formula in D5 as = $C$3*12. Absolute reference remains unchanged 
when that is copied. 

3. Mixed referencing  

In the example of absolute referencing, ―$C$4‖ makes both the row and column absolute. 
On the other hand ―C$4‖ or ―$C4‖ are treated as half relative and half absolute and this 
type of referencing is known as Mixed referencing.  

 (g) Column Headings 

 
 Each Excel spreadsheet contains 256 columns. Each column is named by a letter or 
 combination of letters. 
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(h) Row Headings 

 

 
Each spreadsheet contains 65,536 rows. Each row is named by a number. 

 (i) Name Box 

 
This shows the address of the current selection or active cell. 

 (j) Workbooks and Worksheets 

A workbook automatically shows in the workspace when you open Microsoft Excel 2003. Each 
workbook contains three worksheets. A worksheet is a grid of cells consisting of 65,536 rows by 256 
columns. Spreadsheet information-text, numbers, or mathematical formulas is entered in the different 
cells.  
 
 

 
 

(h) Navigation Buttons And Sheet Tabs 

 

 
 

Navigation buttons allow you to move to another worksheet in an Excel workbook. They are used to 
display the first, previous, next, or last worksheets in a workbook. 
Sheet tabs separate a workbook into specific worksheets. A workbook defaults to three worksheets. 
Each workbook must contain at least one worksheet. 
 

4.6  MS- EXCEL WINDOW ELEMENTS 

 

The following figure shows the various components of MS Excel. 
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Excel Screen Elements 

Title bar 

 
Excel Title bar 

Title bar is located on the top of the Excel Screen. Excel displays the name of the workbook (i.e. file) 
being used currently.  

Menu bar 

 
Excel Menu barMenu bar is located directly below the 'Title bar'. Menu bar contains Menu tabs File, 
Edit, View, Insert, Format, Tool, Data, Window and Help. The first letter of menu tabs is underlined. 
Typing 'Alt + the underlined letter' or a click on the 'Menu tab' will open the drop-down menu 
associated with the tab. Menus are used to give commands to the software.  

Standard Toolbar 

 
Excel Standard Toolbar 
The Standard Toolbar provides shortcuts to various 'commands' being used frequently by the user like 
opening or a creating workbook (file), opening, Saving, printing a workbook, Print preview, Cut, 
Copy, Paste, Undo, Redo, Sum, Sort Ascending, Sort Descending the contents of selected cells, Zoom 
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etc. On moving the mouse over the icons on the tool bar, the command associated with the icon is 
displayed in a pop up.  

- New: to create a new workbook.  
- Open: to open an existing workbook.  
- Save: to save a workbook. If it is for first time, excel will ask for file name and location to 

save. 
- Print: to print a excel file. Print command could print worksheet or workbook.  
- Print preview: using this, we can preview worksheet/workbook before printing.  
- Spell Check: spell check feature is used to correct errors. 
- Research: this feature is used to find words and their meaning. 
- Cut : used to Cut the current selection of text. 
- Copy:  used to make Copy of the selected text. 
- Paste: Pastes the text that has currently cut or copy by the user. 
- Format Painter: used to copy formatting of selected text. 
- Undo And Redo: undo will cancel last action and redo will cancel the undo action.  
- Insert hyperlink: used to create hyperlink. 
- AutoSum and Sorting: by clicking on auto sum, we can have sum of selected range of data 

and sorting button will sort the data. 
- Zoom: helps to change the size of worksheet. 

Format Toolbar 

 
 

Excel Format toolbar 

Format toolbar provides commands for formatting the cells and its contents, merging / de merging 
cells, increasing or decreasing height of rows and width of columns, horizontal and vertical aligning 
of cell contents etc. A user can add or remove icons (commands) to the toolbar as per requirements.  

Functionality of commonly used buttons  

 

Changes the font of the 
selected text  

 

Changes the size of selected 
text and numbers  

 
Makes selected text and 
numbers bold   

Makes selected text and 
numbers italic  

 
Underlines selected text and 
numbers   

Aligns to the left with a ragged 
right margin  

 
Centers the selected text  

 
Aligns to the right with a 
ragged left margin  

 
Merge and Center - Merges 
two or more selected cells 
and centers the entry  

 
Currency Style - Formats 
selected text to display 
currency style  
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Percent Style - Formats 
selected cells to display 
percent  

 
Comma Style - Formats 
selected cells to display 
commas in large numbers  

 
Increase Decimal - Increases 
the number of decimals 
displayed after the decimal 
point  

 
Decrease Decimal - Decreases 
the number of decimals 
displayed after the decimal 
point  

 
Decreases the indent to the 
previous tab stop   

Indents the selected paragraph 
to the next tab stop  

 
Adds or removes a border 
around selected text or 
objects  

 
Marks text so that it is 
highlighted and stands out  

 
Formats the selected text 
with the color you click  

  

Formula Bar 

 
Excel Formula Bar 

Formula bar has Name box on the left to display the address of the selected cell. The other box on the 
formula bar displays number, text, formula or other contents of the selected cell. You can enable or 
disable display of the Formula bar by clicking on View followed adding or removing check mark 
against Formula bar.  

Status bar 

 
Excel Status bar 

The Status bar is located at the bottom of the Excel screen. The bar displays status of the window on 
the left. The word 'Ready' indicates that Excel is in the Ready mode and is awaiting your next 
command. Other indicators appear on the Status bar in the lower right corner of the screen are:  

 The letters "NUM" on the Status bar in the lower right corner of the screen indicate that the 
Num Lock is on.  

 The letters "CAPS" on the Status bar in the lower right corner of the screen indicate that the 
Caps Lock is on.  

 The letters "SCRL" on the Status bar in the lower right corner of the screen indicate that the 
Scroll Lock is on.  

 The letters "END" on the Status bar in the lower right corner of the screen indicate that the 
End key is on.  

 The letters "EXT" on the Status bar in the lower right corner of the screen indicate that the 
Extension of selected cell / range is on. Pressing F8 key anchors a cell / range for extension 
by pressing arrow keys and repressing F8 key removes the anchor. 

A right click on the Status bar displays Sum, Average, Count, Maximum or Minimum of the 
selected cells. You can enable or disable display of the Status bar by clicking on View followed 
adding or removing check mark against Status bar.  
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4.7  Menu 
 The Menu Bar is directly below the Title bar and displays the menu. The menu begins with the word 
File and continues with the following: Edit, View, Insert, Format, Tools, Data, Window, and Help. 
You use the menu to give instructions to the software. Point with your mouse to a menu option and 
click the left mouse button. A drop-down menu will appear. You can now use the left and right arrow 
keys on your keyboard to move left and right across the Menu bar options. You can use the up and 
down arrow keys to move up and down the drop-down menu. To select an option, highlight the item 
on the drop-down menu and press Enter.  

4.7.1 File Menu 

The File menu contains a number of options, which are following:- 

- New - Opens a new document.  
- Open - Opens a previously saved document.  
- Close - Closes the active document but does not quit the application.  
- Save - Saves the active document with its current file name, location and format. 
- Save As - Saves by opening a window which gives the opportunity to change the file name, 

location or format. 
- Page Setup - Sets margins, paper size, orientation and other layout options 
- Print Preview - Shows how the file will look when you print it.  
- Print - Prints the active file, also gives the opportunity to change print options. 
- Exit - Closes Microsoft Excel 

 

 

4.7.2 Edit Menu 

The edit menu contains a number of options, which are following:- 

- Undo - The actual entry of this item will depend on what you did last. As an example 
something is typed, so that was displayed. This selection can be repeated several times. 

- Redo - After an action has been undone, it can be reinstated in the document. 
- Cut - Removes the selection from the active document and places it on the clipboard. 
- Copy - Copies the selection to the clipboard, the cell from which information is copied 

remains highlighted.  
- Paste - Inserts the contents of the clipboard at the insertion point (cursor) or whatever is 

selected. 
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- Paste Special - Ten choices are available when making this selection; examples include 
pasting formulas, values, and comments. 

- Fill - Fill contents of a selected cell Up, Down, Left or Right  
- Clear - Deletes the selected object or text, but does not place it on the clipboard. Four choices 

are available; All, Format, Contents or Comments 
- Delete - This menu entry can be used to delete entire rows or columns.  
- Find - Searches for specified text in the active document 
- Replace - Searches for and replaces specified text and formatting. 

 
4.7.3 View Menu 

The View menu contains a number of options, which are following:- 

- Normal - The default document view for most word processing tasks. 
- Page Break Preview - Before printing, make sure the page breaks appear where you want 

them 
- Toolbars - Displays or hides toolbars. The right pointing arrow indicates a list of toolbars. To 

add one slide down to the name of the toolbar and click to select. 
- Formula Bar - Remove or display the bar which displays cell address and data entered into 

the active cell 
- Header and Footer - Adds or changes the text that is displayed at the top or bottom of every 

page of the document 
- Comments - Hidden comment give further information about cell contents. Comments are 

displayed when you move the cursor into the cell, however this command causes all 
comments on a page to be displayed. 

- Full Screen - Hides most screen elements so you can see more of your document 
- Zoom - Controls how large, or small, the current document appears on the screen. 
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4.7.4 Insert Menu 

The Insert menu contains a number of options, which are following:- 

- Cells - Use this command to insert a cell. A pop-up window allows you to move existing data 
down or to the right. You can also insert rows or columns with this window.  

- Rows - Inserts a new row in the spreadsheet, above the row that contains the active cell.  
- Columns - Inserts a new column in the spreadsheet, to the left of the column that contains the 

active cell.  
- Worksheet - By default, an Excel workbook is made up of three worksheets. we can insert as 

many additional sheets as required. Sheets are inserted in front of the current worksheet. 
- Chart - This adds a chart of the selected data, or of the entire worksheet if you have no data 

selected. 
- Page Break - Inserts page breaks above and to the left of the active cell. To avoid adding a 

page break to the left, make sure a cell in Column A is selected before inserting the break. 
- Function - Opens the Paste Function window allowing the selection of a specific equation to 

go in the active cell.  
- Comment- Have something to say about the contents of a cell? Add a small note with the 

appearance of a Post-It note. 
- Picture - Insert pictures from clip art or a file. You can also insert auto shapes, word art, or a 

chart. 
- Object - Insert an object such as clip art, word art, an equation or much more. 
- Hyperlink – it is used to link worksheet to another worksheet or document. 
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4.7.5 Format Menu 
The Format menu contains a number of options, which are following:- 

- Cells - Format the way a number is displayed, alignment of data in the cell(s), font (size, 
color, style, etc.), borders and colors for the selected cells, and you may also lock the contents 
of a cell here. 

- Row - Specify a row height, choose auto-fit, and hide or un - hide the selected row. 
- Column - Specify a column width, choose auto-fit, hide or un - hide the selected column, or 

choose the standard width for a column.  
- Sheet - Here we can rename the sheet if sheet 1 is not descriptive enough (and it's not), you 

can hide or un - hide a sheet, or you can tile an image in the background of the entire sheet. 
- Auto Format- There are sixteen pre-designed formats to change the look of your spreadsheet. 

You may apply the format to the entire sheet or only to selected cells. 
- Style – Opens a Style window which will lead to the Format Cells window if you wish to 

Modify the format. 
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4.7.6 Tools Menu 

The Tool menu contains a number of options, which are following:- 

- Spelling... - Check spelling in your document 
- AutoCorrect... - Define, or turn off automatic corrections. 
-  Share Workbook... - Choose this option if we want several users to work on the data in the 

same workbook simultaneously. Make it available on  network and anyone with access can 
make changes. 

- Protection - we can password protect a single sheet of a workbook, or the entire workbook. 
One obvious application would be to protect a worksheet which you are using as your grade 
book. 

- Customize... - Select/Deselect toolbars to be displayed within workbook, or add buttons to 
existing toolbars. 

- Options... - This is where you turn those features on or off. 
 

 

 

 
 

 

 

 

 

 

 

 
 

 

 

 

 

 

 
 

 

 

4.7.7 Data Menu 

- Sort – the sort command is very important as it allows you to sort (rearrange) your data either 
in ascending or descending order making it an important command especially when you want 
to analyze your data.  

- Filter – use this command to extract data or a range of data you want from your worksheet. 
There are two types of filters, normal filter and advanced filter.  

- Form – this command turns the selected data into a form that you can use for printing or that 
can be used online. 

-  Subtotals – we can use this command to calculate the subtotals of subtitles you may be 
having and the grand total of your data. 

- Validation – this command is used for setting restrictions on the data type that can be entered 
in a worksheet, for instance you can set a validation criteria where the data entered will be 
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between 20 and 100. This will imply that only numbers between 20 and 100 can be entered 
on the restricted cells.  

- Text to columns – we will not believe this, that this command can be used to convert text to 
column in an Excel sheet. The text will be split into individual columns.  

- Consolidate - this command is useful in combining values from several ranges of data into a 
unified place.  

- Group and online – We can use this command to modify your data by grouping data together 
and also outlining you data. 

- Pivot table and pivot chart report – pivot tables and pivot reports are used to generate a report 
that summarizes and analyzes data. 

- Import export data – use this command to import data from  data sources, use it to create a 
web query, and use it to create a new database query. 

- List – use this command to create a list and publish it.  
- XML – use this command while working with XML (Extensible Markup Language) data.  

 

 

 
 

 

 

 

 

 

 
 

 

 

 

 

4.7.8 Windows Menu 

The Window menu provides different options to move between documents, and these are following: 
- New Window – used to open new window with same content as the active document consists. 

So different parts of document can be viewed at the same time.  
- Arrange All – used to show all open files in separate windows on the screen that makes easy 

dragging between files. 
- Split – used to define a split into two panes or removes the split.  
- Freeze Pane – used to freeze screen. 
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4.7.9 Help Menu 
The Help menu gives the idea to do something in Excel or how something works. This menu has 
following options: 

- Microsoft Excel Help –used to provide the possible topics related to answer of query typed in 
subject of question.  

- Show Office Assistant – it shows an animated paperclip that gives suggestions about what the 
computer thinks related to the work performed by user on document. 

- Microsoft Office Online – used to take the user to website with tips on MS Office software. 
- About Microsoft Excel – it specifies information about Excel i.e license information etc. 

 
 
 

 
 
 
 
 
 
 
 
 
 

4.8  CREATING, OPENING AND SAVING WORKBOOK/WORKSHEET 

4.8.1 Creating a New Workbook 

By default, excel document is called a workbook. Workbooks are named as Book1, Book2 and so on. 
Every workbook contains 3 worksheets. New worksheets can be added anytime in a workbook.  

 To create a new workbook, click New button on standard toolbar.  

 You can also select New from File menu.  

 You can also press Ctrl+ N. 
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4.8.2 Opening a Workbook 

 To Open an existing workbook, click Open button  on standard tool bar.  

 You can also select Open from File menu.  

 You can also press Ctrl+ O. 

 

 

4.8.3 Saving a Workbook 

 To save the document, click Save button  on standard tool bar.  

 You can also click Save from File menu.  

 You can also press Ctrl+S. 

 A dialog box will appear. 

 Save the document with name and extension. 

 

 

Following are the extensions for excel document saving: 
 

1. .xls: saving a workbook.  

2. .xlw: saving workspace. 

3. .xlt: template. 

4. .xlk: backup file. 
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4.8.4 Closing a Workbook 
 
Steps to close a workbook are: 

 Choose close from File menu to close active workbook. 

 We can also press close on right side of menu bar. 

 

 
 
Steps to close excel are: 

 To quit excel, choose Exit from File menu. 

 We can also click on close button on right side of title bar. 

 

 

4.9  BASIC OPERATIONS ON WORKSHEET 

Moving through cells 

 
While working in the worksheet we can use mouse to select a specific cell or row. We can also use 
keyboard to move through cells in a worksheet. 
 

 To move to the next cell, press the Arrow Keys. 

 To move to the next cell to the right, press TAB. 
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 To move to the next cell to the left, press SHIFT + TAB. 

 To move to the edge of a data region, press CONTROL + Arrow Keys. 

 To move to the first cell in the row, press HOME. 

 To move to the first cell, press CONTROL + HOME. 

 To move to the last cell, press CONTROL + END. 

 To scroll down, press PAGE DOWN. 

 To scroll up, press PAGE UP. 

 To scroll to the right, press ALT + PAGE DOWN. 

 To scroll to the left, press ALT + PAGE UP. 

 To move to the next worksheet, press CONTROL + PAGE DOWN. 

 To move to the previous worksheet, press CONTROL + PAGE UP. 

 To go to a cell using the "Go To" dialog box, press F5 to open the "Go To" dialog box, type 

the cell co-ordinates in the Reference box and press ENTER. 

 

Adding Worksheets  

 Click on Insert menu Worksheet. 

 Rename new worksheet. 

 

Adding Rows 
 Select the cell.  

 Click on Insert menu Row 

 A new row will be inserted above the selected cell.  

 

Adding Columns 

 Select the cell.  

 Click on Insert menu Column 

 A new column will be inserted before the selected cell.  

 

Selecting Cells 

 
A cell is to be selected before it is to be used. Single cell can be selected using mouse or keyboard. 

A group of cells selected is called a range. A range is a rectangular group of cells is referred to by its 

diagonal corners(top-left cell address and bottom-right cell address separated by a colon). Example 

A1:C3 implies a rectangle covering all the 9 cells from A1 to C3, i.e. A1, B1, C1, A2, B2, C2, A3, B3 

and C3. 
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Moving cell contents 

 
The contents of a cell can be moved using cut and paste. For this, following are the steps: 

 Choose the cell to be moved. 

 Click on Edit menu Cut. 

 Now, go to that position where data is to be moved. 

 Click on Edit menu Paste.  

 

Copying cell contents 
The contents of a cell can be moved using copied and paste. For this, following are the steps: 

 Choose the cell to be copied.  

 Click on Edit menu Copy. 

 Now, go to that position where data is to be copied. 

 Click on Edit menu Paste.  

Drag and Drop Option 

              

This option can be used to move the cell contents to a short distance. To perform Drag and Drop, 

simply drag the highlighted border of the selected cell to the destination cell using mouse. 

 

Freeze Panes 

  

To make the heading visible at all times in big worksheet, where the heading will disappear as the 

worksheet is scrolled, freeze panes feature is used. It can be performed by following steps: 

 Click the label of the row below the row that should remain frozen at the top of the 

worksheet. 

 For adding Frozen panes, select Window→Freeze Panes from menu bar 

 To remove the Frozen Panes, select Window→Unfreeze Panes from menu bar 

The freeze panes will remain stationary while the remaining rows and column will move 

when worksheet is scrolled.  

 

SUMMARY OF THE LESSON 

 

You learnt the following in this lesson: 

 MS-Excel is spreadsheet package used to organize data and to perform calculations. 

 MS-Excel is used to create the simple database as well as prepare the document for WWW. 

 In MS-Excel, a workbook, by default contains three worksheets. 

 MS-Excel worksheet has a grid of cells arranged in rows which are numbered and columns 

which are named with letters for organizing data and performing mathematical operations.  

 The content of cell can be activated by double clicking on the cell or by clicking once in the 

cell and then pressing function key F2.  

 Different types of Menu, toolbar and their options are used to format the worksheet. 

 Excel toolbars help to use various options such as opening, creating, renaming, merging, 

moving, formatting, analyzing, saving and printing a worksheet. 
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SELF ASSESSMENT QUESTIONS AND EXERCISES 

 

1. Discuss the features of MS-Excel. 

2. How a worksheet can be created? 

3. How rows and columns can be added in Excel worksheet? 

4. Differentiate absolute, reference and mixed referencing in Excel using examples. 

5. Explain the steps to create, save, open and close workbook.  

6. State the steps for opening and saving of worksheet.  

7. How can the content of a cell in MS-Excel be activated? 

8. State the steps to Move Cells content. 

9. State the steps to Copy Cells content. 

10. Write the steps to fill color in a cell.              
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CHAPTER - 5 

WORKING WITH MICROSOFT EXCEL 

OBJECTIVES OF THIS LESSON 

This lesson is aimed to make you understand the advanced features of MS-Excel. At the end of this 

lesson the learner should be able to carry out the following the following: 

 Formatting and printing of worksheet 

 Linking of different worksheets 

 Creation and printing of charts or graphs 

 Recording and Playing Macros 

 Using built-in functions 

 

STRUCTURE OF THIS LESSON 

5.1 Introduction 

5.2 Formatting Worksheet 

 5.2.1 Standard Formatting 

 5.2.2 Conditional Formatting 

 5.2.3 Auto Formatting 

5.3 Printing Worksheet 

5.4 Establishing Worksheet Link 

5.5 Creating a Table  

5.6 Charts (Graphs) in Excel  

 5.6.1 Standard Chart Types  

 5.6.2 Creating a Chart 

 5.6.3 Adding Graphics  

5.7 Printing a Chart  

5.8 Macro 

 5.8.1 Recording a Macro 

 5.8.2 Running a Macro 

5.9 Built in Functions 

 

 Summary of the Lesson 

 Self Assessment Questions And Exercises 

    

5.1 INTRODUCTION 

Previous lesson introduced various components of MS-Excel along with the basic operations that you 

can perform while working on a worksheet. However, MS Excel provides lot of other features which 

are very useful for preparing professional worksheets. Such features include formatting, printing, 

charts, macros and built-in-functions. All these features are discussed in detail in the subsequent 

sections of this lesson. 
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5.2 FORMATTING WORKSHEET 

You can give professional look to worksheet by formatting it in many ways. Formatting is a process 

of presenting the data in an effective manner with respect to alignment, font, font size, font color, 

border pattern etc. There are many ways of formatting the worksheet; few commonly used methods 

are discussed as follows: 

 

5.2.1 Standard Formatting 

To change the font used in a cell or range of cells 

 Select the cell or range of cells you wish to change. 

 On the Excel Formatting toolbar choose a font from the Font drop down list. 

To change other font characteristics 

 Select the cell or range you wish to change. 

 From the Format menu, click Cells . 

 From the Format Cells  dialog box displayed, select the Font tab to change the Font, font 

style , or size. 

 Select the Underline: drop down list box to select a style of underline or None to remove the 

underlining. 

 Select the Color: drop down list box to choose a font color. 

 In the Effects section, you can tick Strikethrough, Superscript, or Subscript. 

 To change all the settings in the dialog box back to the Normal style which is set in the Style 

dialog box, tick the Normal font check box. 

 Select OK to close the Format Cells dialog box. 

To align data between the left and right sides of a cell 

 Select the cell, or cells, you wish to align.  

 On the Excel Formatting toolbar, click on the Align Left icon to align data with the left 

edge of the cell.  

 Click on the Align Right icon to align data with the right edge of the cell.  

 Click on the Center icon to center data in the cell. 

To align data between the top and bottom of a cell 

 Select the cell, or cells, you wish to align.  

 From the Format menu, click Cells . 

 From the Format Cells  dialog box displayed, click on the Alignment tab. 

 In the Text alignment section, choose the Top, Center, or Bottom option in the Vertical area 

to align the data in the cell. 

 To make the lines of data fit evenly within the height of a cell, tick the Justify distributed 

option and click on OK. 

 

To change the orientation of data cells 

 Select the cell, or cells, you wish to change. 

Remarks 



Working with Microsoft Excel  

 
 From the Format menu, click Cells . 

 From the Format Cells  dialog box displayed, click on the Alignment tab. 

 In the Orientation section, you can change the Degrees  of the text or use the mouse to drag 

the 'red small diamond' up or down. When satisfied, click on OK. 

 

 

To wrap multiple lines of data in a cell 

 Type the data you require into the cell and press Enter. The entry will appear as one long 

line.  Select the cell, or cells, you wish to format.  

 From the Format menu, click Cells . 

 From the Format Cells  dialog box displayed, click on the Alignment tab. 

  In the Text control section, tick the Wrap text check box and click on OK. 

To shrink the text into one cell 

 Type the data you require into the cell and press Enter.  

 From the Format menu, click Cells . 

 From the Format Cells  dialog box displayed, click on the Alignment tab. 

 In the Text control section, tick the Shrink to fit check box and click on OK. 

To merge several cells 

 Select the cells that you wish to merge to become one cell.  

 Right-click on the selected cells, click Format Cells . 

 From the Format Cells  dialog box displayed, click on the Alignment tab. 

 In the Text control section, tick the Merge cells check box and click on OK. 

Note: You also can use the Merge and Center icon on the Excel Formatting toolbar. 

To change the color of text 

 Select the cells containing the data you want to change the color.  

 On the Excel Formatting toolbar, click the down arrow next to the Font Color icon. 
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 Choose a color from the Font Color palette. 

 The color you selected from the Font Color palette will be displayed on the new icon face. 

Click on the icon face to apply the new color to the cell.  

To apply colors to cell(s)  

 Select the cell or range of cells you wish to color.  

 On the Excel Formatting toolbar, click the down arrow next to the Fill Color icon. 

  Choose a color from the Fill Color palette. 

 

To turn off the cell(s) color 

 Select the cell or range of cells you wish to color.  

 On the Excel Formatting toolbar, click the down arrow next to the Fill Color icon. 

 Choose No fill. 

To change number formatting using the formatting icons 

 We can quickly change the formatting of a cell or selected range by using the following icons 

on the Formatting toolbar.  
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Currency  12345 will become $12,345.00  

Percent  .25 will become 25%  

Comma  98765 will become 98,765.00  

Increase Decimal  12,345.00 will become 12,345.000  

Decrease Decimal  98,765.00 will become 98,765.0  

 

To format a number as a currency 

 Select the cell or range of cells you want to format.  

 From the Format menu, click Cells .  

 From the Format Cells  dialog box displayed, select the Number tab.  

 In the Category: section, select Currency.  

 
 

 

 Select the number of decimal places you require by using the Decimal places: spin box 

arrows. 

  In the Symbol: section drop down list, select the type of currency. 

  Click OK. 
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To format a number as a percentage 

 

 Select the cell or range of cells you wish to format. 

 From the Format menu, click Cells . 

 From the Format Cells  dialog box displayed, select the Number tab. 

 In the Category: section, select Percentage. 

 Select the number of decimal places you require by using the Decimal places: spin box 

arrows. 

 Click OK 

 

5.2.2 Conditional Formatting 

 

This feature helps to copy the formatting style from a selected cell to another. To do this, simply copy 

the cell and paste its format to another cell. We can also copy format to a range of cells. Following 

are the steps: 

 Select the range of cells in the worksheet to which conditional format is to be copied. The cell 

is to be copied must be the part of the range. 

 Select Format menu Conditional Formatting.  

 A dialog box will appear. 

 
 Fill the required details. 

5.2.3 Auto Formatting 

This feature is helpful to obtain professional-quality format for data. Auto formats are combinations 

of formats, such as lines and fills, that Excel applies to the indicated range of cells. Steps for Auto 

formatting are : 

 Select cell(s) in table. 

 Click Format menu, then click AutoFormat. 

 Click Premade format in Table Formats  list, to select the appropriate format. 

 Click Ok when done. 

5.3 PRINTING  WORKSHEET 

Before printing the worksheet one needs to make sure that it will appear presentable. For this printout 

orientation, scaling, margins, header and footer, and page numbering should be setup.  

 

 To Print an active document, click Print button on standard toolbar. 

 You can also click Print on File menu.  
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 You can also press Ctrl+P. 

 A dialog box will appear. 

 Fill all the necessary information and press OK. 

 
 

 

 
 

5.4 ESTABLISHING WORKSHEET LINK 

Before creating the link, format the cell containing the link formula in the destination worksheet to 

equal the format of the source data. 

1. In the source worksheet, select the cell you want to link to and click the Copy button on the 

Edit menu. Or press Ctrl+C, or right-click and select Copy. 
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2. Switch to the destination spreadsheet and click the cell where you want the link. Then, on the 

Edit menu, click Paste Special, and then click Paste Link. 

 

 

 

 

 

3. Return to the source worksheet and press ESC to remove the animated border around the cell.  
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5.5 CREATING A TABLE 

 

 Select a range of rows and columns. This range may contain values or it may be empty.  

 Click on Data menu and then choose table. 

 

 

 A dialog box will appear. Specify number of rows and columns.  
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5.6 CHARTS (GRAPHS) IN EXCEL 

 

A chart is a graphical representation of the data in your worksheet. You can create an embedded 

chart, which appears on the worksheet beside the data, or, you can create a chart sheet as a separate 

sheet in the workbook so that it can be displayed apart from its associated data. Whichever method 

you choose your chart data is automatically linked to the worksheet from which it was created. If you 

change the data on the worksheet, the chart will change accordingly.  

Excel offers many different chart types, each of which has several subtypes or variations: 

 Column 

  Bar  

 Line  

 Pie  

 XY (scatter) 

  Area  

 Doughnut  

 Radar  

 Surface 

 Bubble  

 Stock  

 Cone  

 Cylinder 

  Pyramid  

 

5.6.1 Standard Chart Types  

 

The main chart types are as follows (arranged in alphabetical order):  

 Area chart  

 

An area chart shows the relative importance of values over a period of time. It is similar to a 

line chart but emphasizes the amount of change (Magnitude of values)  rather than time and 

the rate of change.  

 

 Bar chart  

 

Bar charts illustrate comparisons between items. Although they are similar to column charts, 

the categories on a bar chart are displayed vertically and the values are organized 

horizontally. This concentrates on comparing values and places less emphasis on time. A 

stacked bar chart shows the relationship of individual items to the whole.  
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 Bubble chart  

 

A bubble chart is a variation on an xy scatter plot. The size of the bubble (data marker) 

indicates the value of a third variable. Arrange the data with x values in one column (or row) 

and the corresponding y values and bubble size in the adjacent columns (rows).  

 

 Column chart  

 

Column charts can be used to illustrate how data changes over a period of time, and to 

compare various items. Categories are displayed horizontally, values vertically.  

 

 Doughnut chart  

 

Doughnut charts are similar to pie charts but, unlike pie charts, can show more than one data 

series. Each ring represents one data series. These charts are widely used in the Far East.  

 

 Line chart  

 

This shows trends or changes in data over a period of time, at even intervals. A line chart 

emphasizes time flow and rate of change rather than the amount of change. If you need to 

show trends or changes in data at uneven or clustered intervals, an xy (scatter) chart is more 

appropriate. 

 

 Pie chart  

 

A pie chart can only show one data series. It compares the size of  individual items with the 

sum of them all.  

5.6.2 Creating a Chart 

 Choose a range of data for which we want to make a chart. 

 Either Click on the Chart Wizard button on the toolbar  

Or 

Select Chart from the Insert menu.  

 

The first Chart Wizard dialog box will appear. The Chart Wizard –  

Step 1 of 4 – Chart Type dialog box that appears has two tabs. The popular built-in chart types can be 

found on the Standard Types tab. Chart types designed by us, the user, and combination charts 

designed by Excel, can be found on the Custom Types tab.  
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Step 2 of 4 – Specify the data to be plotted i.e. the source of data for which chart is to be created. 
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Step 3 of 4 – The number of tabs displayed in the Step 3 – Chart Options window varies, depending 

on the chart type. Here we have three options— Titles, Legend and Data Labels. 

 
Step 4 of 4 – Specify chart location in window, we can specify where this new chart is to go. You can 

choose to place the chart. 

 
 

• As new sheet in which case a chart sheet containing just the chart will be entered in workbook — 

type a name for the sheet in the adjacent box.  

• As object is so that the chart will be placed in an existing worksheet  

— the current one where our data is, or a different one (click on the down-arrow to select one).  

5.6.3 Adding Graphics  

Graphics can easily be added to charts and are a useful way to draw attention to a particular feature or 

to provide an explanation. We may decide to add an arrow and some text to chart. Whatever we are 

doing, you should first make sure that the Drawing toolbar is visible:  
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Select View | Toolbars | Drawing 

There are two possible scenarios:  

• The graphics are confined to the area of the chart  

• The graphics are partly/completely outside the chart area  

Adding graphics  

 Click on the chart to select it.  

 Click on the Arrow button on the Drawing toolbar.  

 Draw an arrow on your chart.  

If the graphics are confined to the area of the chart, we can move the chart and the arrow  will move 

with it. If the graphics are partly outside the chart area, the arrow will not move with the chart unless 

we also:  

 Select the chart, arrow and text box (using Shift+click).  

 Right-click on this selection.  

 Select Grouping | Group.  

 Click away from the selection.  

5.7 PRINTING A CHART 

 To print a chart that is on a separate chart sheet, Activate the chart sheet and print as usual.  

 To print a chart that is an object on a worksheet 

1. Select the chart and choose File | Print — the chart will be printed  

             on its own. Or  

2. Select an area of the worksheet containing the chart; choose 

             File | Print and change the Print what setting to Selection — the chart  

             will be printed together with the worksheet cells that were selected.  

 

5.8 MACRO 

A macro is a set of instructions that tells Microsoft Excel to perform one or more actions as per user 

requirements. Macros are like computer programs, but they run completely within Excel. We can use 

them to automate tedious or frequently repeated tasks. 

Macros can carry out sequences of actions much more quickly. For example, we can create a macro 

that enters a series of dates across one row of a worksheet, centers the date in each cell, and then 

applies border format to the row. Or we can create a macro that defines special pr int settings in the 

Page Setup dialog box and then prints the document.  

Macros can be simple or extremely complex. They can also be interactive; that is, we can write 

macros that request information from the user and then act on that information.  

There are two ways to create a macro: we can record it, or we can build it by entering instructions in a 

module. Either way, the instructions are encoded in the programming language Microsoft Visual 

Basic for Applications (VBA).  

 

5.8.1 Recording a Macro 

 On the Tools menu, point to Macro, and then select Record New Macro.  

 In the Macro name box, enter the name of the macro. Click Ok. 

 A Stop Recording toolbar will appear. Drag it to a new position if it is in the way.  

 Perform actions we want to record. 

 Press stop recording on toolbar. A macro will be saved. 
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5.8.2 Running a Macro 

 Click on Tools menu, select Macro. 

 A list of macros, earlier saved will appear. Choose macro we want to run.  

 Click Run. 

 

 

5.9  BUILT IN FUNCTIONS 

Functions are power tools which help to perform calculations on data. FUNCTIONS are predefined 

formulas that will calculate selected data.  The user has to simply provide the values based upon 

which calculations are to be done. All Excel functions consist of three (3) parts: The = sign, the 

function name, and an argument or range enclosed in parentheses. 

A FUNCTION is always identified by the  =SIGN preceding the function name. The FUNCTION 

NAME indicates which function is being used. The ARGUMENT or RANGE is enclosed in 

parentheses and specifies the range of cells on which the function will act. The ARGUMENT can be 

a real number, a reference to a cell, a reference to a group of cells, a formula, or another function. A 

function can be added to the worksheet by two methods: 

1. Place the cursor where you want the function result to appear and select Function from Insert 

menu. 
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2. Manually type the function at desired place. 

 

 

 

 

 

 

 

Functions are characterized by purpose. There are 9 function categories.  

1. Mathematical Functions 

 With math and trigonometry functions, we can perform simple and complex mathematical 

calculations  

 

- SUM (Range)- Sum of a group of numbers  

- SQRT(X) - Displays the square root of a number (X)  

- PRODUCT (range) – multiplication of given values 

- MODE (argument 1, argument 2) – will give remainder after dividing argument 1 by 

argument 2 

 

2. Statistical Functions 

Statistical worksheet functions perform statistical analysis on ranges of data. This includes 

average, highest and lowest values, standard deviation, median, and other statistics.  

- AVERAGE (Range) - Gives the average of a group of numbers  

- COUNT (Range) - Counts the items in a list  

- MIN (Range) - Displays the smallest number in the range  

- MAX (Range) - Displays the largest number in the range  

 

3. Financial Functions   

Financial functions perform common business calculations, such as determining the payment for  

a loan, the future value or net present value of an investment,  the principle and interest etc. 

- FV – To calculate future value of investment 

- IPMT – to find interest payment 

 

4. Logical Functions 

Logical functions are used to see whether a condition is true or false or to check for multiple 

conditions. Like, 

- AND 

- OR 

- NOT 

- IF 

5. Lookup Functions 

 When we need to find values in lists or tables or when you need to find the reference of a cell, 

we can use the lookup and reference worksheet functions.  

- ADDRESS -  returns a cell reference as text 

- COLUMN – returns the column number of reference 

- COLUMNS – returns number of columns in a array of reference 
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6. Text Functions 

 With text functions, we can manipulate text strings in formulas. For example, we can change the 

case or determine the length of a text string. We can also join, or concatenate, a date to a text 

string. To manipulate the text, excel provides many functions like  

- CHAR 

- CODE  

- FIND 

- LEFT  

- LEN 

- LOWER  

- REPLACE  

- RIGHT  

- SEARCH 

 

7. Date & Time Functions 

 With date and time functions, we can analyze and work with date and time values in formulas. 

For example, if we need to use the current date in a formula, use the TODAY worksheet function, 

which returns the current date based on computer's system clock. There are other main function 

like  

- DATE 

- DAY  

- MONTH 

- NOW  

- TIME  

- YEAR 

 

8. Engineering Functions: The engineering worksheet functions perform engineering analysis.  

 

9. Database Functions: A set of functions that allows calculations on database. Following are 

the functions: 

DAVERAGE – returns the average of values in a list or database. 

DCOUNT – counts the cells in a record that matches a specified condition 

DMAX – returns the maximum value from the list or database 

DMIN – returns the minimum value from the list or database 
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SUMMARY OF THE LESSON 

 

You learnt the following in this lesson: 

 Formatting is done to give the professional look to worksheet. 

 Charts can be created easily with the help of chart wizard. 

 In Excel all formula begin with the (=) equal sign. 

 Function is a built in formula in Excel. 

 All elements of a chart can be alter after creating it.  

 Macro facility is also available in MS-Excel. These are called to speed up any general editing 

sequence that a user executes in Excel spreadsheet. 

 Data can be represented in graphical format using chart or graph option.  

 Worksheets can be linked using hyperlink command.  

 MS-Excel provides various built-in functions for different purposes such as mathematical 

functions, statistical functions, logical functions etc. 

 Numbers can be formatted in date, time, currency and scientific notations.  
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SELF ASSESSMENT QUESTIONS AND EXERCISES 

 

11. How different worksheets can be linked with each other? 

12. How worksheet functions can be categorized? 

13. Write the structure of the Function.  

14. Discuss various logical and statistical functions. 

15. State the purpose of different mathematical functions.  

16. How charts or graphs can be created in MS-Excel? 

17. Write the steps to print a graph or chart. 

18. What is the use of ‗Macros‘ in MS-Excel? 

19. Explain the steps to Record and Run a Macro. 

20. What is the advantage of using keyboard shortcuts? 

21. What is column chart? 

22. What do you mean by sum function? 

23. What is count function? 

24. Write the steps to use Average( ) function. 

25. What is the purpose of SQRT ( ) function?     
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